Particle tracking
D-WAQ PART

Simulation of mid-field water quality and oil spills, using particle tracking

User Manual

D-Water Quality

Version: 2.15
SVN Revision: 66766
15 July 2020
## Contents

### List of Figures
- vii

### List of Tables
- xi

### 1 A guide to this manual
1.1 Introduction ................................................. 1
1.2 Manual version and revisions ............................... 1
1.3 Typographical conventions .................................. 1
1.4 Changes with respect to previous versions ............... 2

### 2 Introduction to D-WAQ PART
2.1 Short description of the program functionality .......... 5
2.2 Specification of the program package ..................... 7
2.3 Installing the program ...................................... 8
2.4 Error checking ............................................. 8
2.5 Particle tracking module within Delft3D .................. 8
2.6 Input data files ............................................ 9
2.7 Limitations in PART-GUI ................................... 9

### 3 Getting started
3.1 Starting Delft3D ........................................... 11
3.2 Particle tracking module .................................. 11
3.3 Change working directory ................................ 11
3.4 Coupling module ......................................... 13
3.4.1 Introduction ........................................... 13
3.4.2 Coupling GUI ......................................... 16
3.4.3 Running the coupling module ......................... 18
3.5 Starting PART-GUI ....................................... 19
3.5.1 Accessing the data groups ......................... 20
3.5.2 Visualisation Area window .......................... 20
3.5.3 Editing tables ...................................... 21
3.5.4 Saving a D-WAQ PART input file .................. 21
3.6 Quitting the program ..................................... 22

### 4 Graphical User Interface
4.1 General ................................................. 23
4.1.1 Initial conditions ................................... 23
4.1.2 Boundary conditions .................................. 23
4.1.3 Co-ordinate system .................................. 23
4.1.4 Data groups .......................................... 23
4.2 Description ............................................ 23
4.3 Hydrodynamics .......................................... 24
4.3.1 Number of layers in hydrodynamics .............. 25
4.4 Substances .............................................. 26
4.4.1 Tracers ............................................... 26
4.4.2 Oil ................................................ 27
4.5 Time frame .............................................. 28
4.5.1 Date-time format .................................... 29
4.5.2 Start time ........................................... 29
4.5.3 Stop time ............................................ 29
4.5.4 Time step ............................................ 29
4.5.5 Reference time input ............................... 29
4.6 Initial condition ....................................... 30
### 4.7 Numerical parameters
- 4.7.1 Number of particles ........................................... 30
- 4.7.2 Vertical dispersion ........................................... 31

### 4.8 Instantaneous releases ........................................... 32
- 4.8.1 Co-ordinates of instantaneous release location .............. 33
- 4.8.2 Particles used ........................................... 34
- 4.8.3 Radius of instantaneous release ................................ 34
- 4.8.4 Release time and mass of release ................................ 34

### 4.9 Continuous releases ........................................... 36
- 4.9.1 Co-ordinates of continuous release location ................. 37
- 4.9.2 Particles used ........................................... 38
- 4.9.3 Radius of continuous release ................................ 38
- 4.9.4 Release time and rate ....................................... 38
- 4.9.5 Concentration of continuous release ......................... 39

### 4.10 Process parameters ........................................... 40
- 4.10.1 Decay rates ........................................... 40
- 4.10.2 Sedimentation/erosion ....................................... 41
- 4.10.3 Physical parameters ......................................... 44
- 4.10.4 Oil Model parameters ........................................ 46

### 4.11 Observation points ........................................... 49

### 4.12 Output options ........................................... 51
- 4.12.1 Map file ........................................... 51
- 4.12.2 Zoom grid ........................................... 52
- 4.12.3 Particle tracks ........................................... 54
- 4.12.4 Output file types ........................................... 54

### 4.13 Executing the scenario ........................................... 55
- 4.13.1 Executing the water quality mid-field module D-WAQ PART ........... 55
- 4.13.2 Estimating run time ....................................... 55
- 4.13.3 File sizes ........................................... 55

### 5 Tutorial ........................................... 57
- 5.1 Introduction ........................................... 57
- 5.2 D-WAQ PART tutorial cases .................................... 57
  - 5.2.1 Tutorial cases ........................................... 57
  - 5.2.2 Starting D-WAQ PART ..................................... 58
- 5.3 Coupling the hydrodynamic results ................................ 58
  - 5.3.1 Coupling module ........................................... 58
  - 5.3.2 Definition of the input ..................................... 58
  - 5.3.3 Saving input and running the coupling module ............... 62
- 5.4 Case 1: Tracer ........................................... 63
  - 5.4.1 Description ........................................... 64
  - 5.4.2 Hydrodynamics ........................................... 65
  - 5.4.3 Substances ........................................... 65
  - 5.4.4 Time frame ........................................... 66
  - 5.4.5 Numerical parameters ..................................... 67
  - 5.4.6 Instantaneous releases ..................................... 68
  - 5.4.7 Continuous releases ..................................... 71
  - 5.4.8 Process parameters ....................................... 73
  - 5.4.9 Observation points ....................................... 76
  - 5.4.10 Output options ........................................... 77
  - 5.4.11 Saving the input ........................................... 79
- 5.5 Case 2: Oil ........................................... 80
  - 5.5.1 Description ........................................... 81
  - 5.5.2 Hydrodynamics ........................................... 82
## List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1</td>
<td>Example of a D-WAQ PART oil spill simulation</td>
<td>6</td>
</tr>
<tr>
<td>2.2</td>
<td>Software architecture around the particle tracking module</td>
<td>8</td>
</tr>
<tr>
<td>3.1</td>
<td>Main window of Delft3D-MENU</td>
<td>11</td>
</tr>
<tr>
<td>3.2</td>
<td>Particle tracking menu in Delft3D-MENU</td>
<td>12</td>
</tr>
<tr>
<td>3.3</td>
<td>Select working directory window</td>
<td>12</td>
</tr>
<tr>
<td>3.4</td>
<td>Repeating a tidal cycle of 12 hours stored on the communication file, for a D-WAQ PART simulation of 36 hours</td>
<td>14</td>
</tr>
<tr>
<td>3.5</td>
<td>Principle of vertical aggregation where 10 layers in the hydrodynamic simulation are aggregated to 5 layers in the water quality simulation</td>
<td>15</td>
</tr>
<tr>
<td>3.6</td>
<td>Hydrodynamic coupling selection window</td>
<td>15</td>
</tr>
<tr>
<td>3.7</td>
<td>COUP-GUI window</td>
<td>16</td>
</tr>
<tr>
<td>3.8</td>
<td>Hydrodynamics sub-window in COUP-GUI</td>
<td>17</td>
</tr>
<tr>
<td>3.9</td>
<td>Vertical aggregation using the Layer editor</td>
<td>18</td>
</tr>
<tr>
<td>3.10</td>
<td>Main menu of PART-GUI</td>
<td>19</td>
</tr>
<tr>
<td>3.11</td>
<td>Hydrodynamics Data Group</td>
<td>20</td>
</tr>
<tr>
<td>3.12</td>
<td>Selecting the Visualisation Area window</td>
<td>20</td>
</tr>
<tr>
<td>3.13</td>
<td>Visualisation Area window</td>
<td>21</td>
</tr>
<tr>
<td>3.14</td>
<td>Table editing options in the PART-GUI main menu bar</td>
<td>21</td>
</tr>
<tr>
<td>3.15</td>
<td>Saving the input file</td>
<td>22</td>
</tr>
<tr>
<td>3.16</td>
<td>Exiting the program</td>
<td>22</td>
</tr>
<tr>
<td>3.17</td>
<td>Window to save &lt;*.mdp&gt; file before quitting</td>
<td>22</td>
</tr>
<tr>
<td>4.1</td>
<td>Data Group Description</td>
<td>24</td>
</tr>
<tr>
<td>4.2</td>
<td>Data Group Hydrodynamics</td>
<td>24</td>
</tr>
<tr>
<td>4.3</td>
<td>Navigation window to select a hydrodynamic scenario</td>
<td>25</td>
</tr>
<tr>
<td>4.4</td>
<td>Data Group Substances when Tracers are selected</td>
<td>25</td>
</tr>
<tr>
<td>4.5</td>
<td>Confirmation window to delete substance</td>
<td>27</td>
</tr>
<tr>
<td>4.6</td>
<td>Data Group Substances when Type of model Oil is selected</td>
<td>27</td>
</tr>
<tr>
<td>4.7</td>
<td>Time Frame Data Group</td>
<td>28</td>
</tr>
<tr>
<td>4.8</td>
<td>Data Group Initial Condition</td>
<td>29</td>
</tr>
<tr>
<td>4.9</td>
<td>Data Group Numerical Parameters</td>
<td>30</td>
</tr>
<tr>
<td>4.10</td>
<td>Instantaneous Releases Data Group for tracer substances</td>
<td>32</td>
</tr>
<tr>
<td>4.11</td>
<td>Release tables for instantaneous releases window for defining release time and mass of release</td>
<td>33</td>
</tr>
<tr>
<td>4.12</td>
<td>Instantaneous Releases Data Group for oil substances</td>
<td>35</td>
</tr>
<tr>
<td>4.13</td>
<td>Continuous Releases Data Group for tracer substances</td>
<td>36</td>
</tr>
<tr>
<td>4.14</td>
<td>Release tables for continuous releases window for defining release time, discharge and concentration of release</td>
<td>37</td>
</tr>
<tr>
<td>4.15</td>
<td>Process parameters Data Group</td>
<td>39</td>
</tr>
<tr>
<td>4.16</td>
<td>Process Parameters Data Group for oil modelling</td>
<td>40</td>
</tr>
<tr>
<td>4.17</td>
<td>Decay rates sub-window</td>
<td>40</td>
</tr>
<tr>
<td>4.18</td>
<td>Sedimentation/erosion sub-window</td>
<td>41</td>
</tr>
<tr>
<td>4.19</td>
<td>Sediment/Erosion constants sub-window</td>
<td>41</td>
</tr>
<tr>
<td>4.20</td>
<td>Settling velocities sub-window</td>
<td>43</td>
</tr>
<tr>
<td>4.21</td>
<td>Physical parameters sub-window</td>
<td>45</td>
</tr>
<tr>
<td>4.22</td>
<td>Oil Model input for the Oil model</td>
<td>47</td>
</tr>
<tr>
<td>4.23</td>
<td>Observation Points Data Group</td>
<td>50</td>
</tr>
<tr>
<td>4.24</td>
<td>Output Options Data Group</td>
<td>51</td>
</tr>
<tr>
<td>4.25</td>
<td>Definition of Zoom grid</td>
<td>52</td>
</tr>
<tr>
<td>4.26</td>
<td>Defining zoom grid using the Visualisation Area window</td>
<td>53</td>
</tr>
<tr>
<td>4.27</td>
<td>Definition of Zoom grid output time intervals</td>
<td>53</td>
</tr>
</tbody>
</table>
5.1 Coupling GUI - Data Group Description ........................................ 59
5.2 Vertical aggregation using the Layer editor. Left not aggregated and right aggregated layers. .................................................. 60
5.3 Coupling GUI - Data Group Hydrodynamics .................................. 61
5.4 Coupling GUI - Data Group Dispersion ...................................... 62
5.5 Coupling report output window .................................................. 62
5.6 Selection window for Particle tracking ....................................... 63
5.7 Main window of the PART-GUI .................................................. 64
5.8 Data Group Description .......................................................... 64
5.9 Data Group Hydrodynamics showing the selected hydrodynamic results <com-
tut_fti_part.hyd> ..................................................................... 65
5.10 Data group Substances ............................................................ 66
5.11 Data Group Time Frame .......................................................... 67
5.12 Data Group Numerical Parameters after editing .......................... 67
5.13 Data Group Instantaneous Releases .......................................... 69
5.14 Release tables for instantaneous releases window of a selected instantaneous release ......................................................... 70
5.15 Visualisation Area window ........................................................ 70
5.16 Data Group Continuous Releases .............................................. 72
5.17 Release tables for continuous releases window of continuous release 1 ................................................................. 72
5.18 Data Group Process Parameters with sub-data group Decay rates ................................................................. 73
5.19 Sub-data group Sedimentation/erosion – Constants ..................... 74
5.20 Settling Velocities details (A0 list box selected) ......................... 75
5.21 Physical Process parameters .................................................... 76
5.22 Data Group Observation Points ................................................ 77
5.23 Data Group Output Options, with also showing options for Grid Definition of the Zoom grid .................................................. 78
5.24 Zoom Grid Output ................................................................. 79
5.25 Selection window for Particle tracking ...................................... 80
5.26 Main window of the PART-GUI ................................................ 81
5.27 Data Group Description .......................................................... 81
5.28 Data Group Hydrodynamics showing the selected hydrodynamic results <com-
tut_fti_part.hyd> ..................................................................... 82
5.29 Data Group Substances ............................................................ 83
5.30 Data Group Time Frame .......................................................... 84
5.31 Data Group Initial Condition .................................................... 85
5.32 Selection window for the initial conditions file ......................... 85
5.33 Data Group Numerical Parameters .......................................... 86
5.34 Data Group Instantaneous Releases .......................................... 87
5.35 Release tables for instantaneous releases window for oil patch 1 ................................................................. 88
5.36 Release tables for instantaneous releases window for oil patch 2 ................................................................. 88
5.37 Data Group Process parameters with sub-data group Decay rates ................................................................. 90
5.38 Sub-data group Sedimentation/Erosion .................................... 90
5.39 Settling Velocities details (A0 selected in list box) ..................... 91
5.40 Physical Process parameters .................................................... 92
5.41 Oil Model specific parameters .................................................. 93
5.42 Data Group Observation Points ................................................ 94
5.43 Data Group Output Options, also showing options for Definition of Zoom grid ................................................................. 95
5.44 Zoom Grid Output ................................................................. 96
5.45 Tracer Case: Instantaneous release: situation at 18:00 hrs (upper) and 19:30 hrs (lower) in the surface layer ................................................ 98
5.46 Tracer Case: Continuous release: situation at 20:30 hrs in layer 3: MAP-file (upper) and PLO-file (lower) ................................................ 99
5.47 Oil Case: Situation at 19:30 hrs in the surface layer: Ekofisk dispersed (upper) and Floating HFO (lower) ........................................................................................................ 100
5.48 Oil Case: Situation at 17:00 hrs (upper) and 19:30 hrs (lower), PLO-file for Floating HFO in the surface layer ..................................................................................... 101
6.1 Vertical dispersion coefficient and its gradient as a function of relative depth for the $k-L$ turbulence model ................................................................................... 107
6.2 Relationship between viscosity and the dispersion parameter $C_0$ (Delvigne and Hulsen, 1994) ........................................................................................................... 113
# List of Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1</td>
<td>Limitations of the PART-GUI</td>
<td>9</td>
</tr>
<tr>
<td>5.1</td>
<td>Specifications of the tutorial cases</td>
<td>57</td>
</tr>
<tr>
<td>5.2</td>
<td>Timers for the Tracer tutorial case</td>
<td>66</td>
</tr>
<tr>
<td>5.3</td>
<td>Details of dye release 1</td>
<td>69</td>
</tr>
<tr>
<td>5.5</td>
<td>Details of the continuous release</td>
<td>71</td>
</tr>
<tr>
<td>5.7</td>
<td>Process parameters</td>
<td>75</td>
</tr>
<tr>
<td>5.8</td>
<td>Time breakpoints definition</td>
<td>79</td>
</tr>
<tr>
<td>5.9</td>
<td>Timers for the Oil tutorial case</td>
<td>84</td>
</tr>
<tr>
<td>5.10</td>
<td>Details of oil releases</td>
<td>87</td>
</tr>
<tr>
<td>5.12</td>
<td>Process parameters for Sedimentation and Erosion</td>
<td>91</td>
</tr>
<tr>
<td>5.13</td>
<td>Physical process parameters</td>
<td>92</td>
</tr>
<tr>
<td>5.14</td>
<td>Process parameters for oil</td>
<td>93</td>
</tr>
<tr>
<td>5.15</td>
<td>Time breakpoints definition</td>
<td>96</td>
</tr>
</tbody>
</table>
1 A guide to this manual

1.1 Introduction

In order to make this manual more accessible, a brief description of the contents of each of the chapters will be given here. If you are a novice user of D-WAQ PART, you are advised to work through the tutorial that is provided in Chapter 5. This should be done in combination with Chapter 4, where the graphical user interface options are explained in detail.

This document describes the operation of PART within the Delft3D suite.

- **Chapter 2: Introduction to D-WAQ PART**, a short overview of the program is given together with some specifications of the program package.
- **Chapter 3: Getting started**, the general functionality of the D-WAQ PART framework is described, together with a brief description of how to start and quit the program.
- **Chapter 4: Graphical User Interface**, provides a detailed description of the Graphical User Interface (PART-GUI).
- **Chapter 5: Tutorial**, provides you with step-by-step instructions to complete a “tracer” and an “oil” tutorial case. Both result in a complete input file and can be executed. Output from the tutorial cases can be compared with the results provided. The emphasis here is to provide practical experience in the use of the module.
- **Chapter 6: Conceptual model**, gives an overview of the modelling concepts used in D-WAQ PART.
- **Chapter 7: Algorithmic implementation**, describes the algorithms for the advection and dispersion schemes.
- **References**, provides the references used in this manual.
- **Appendix A: Input files D-WAQ PART**, a description of the ASCII input file (generated by PART-GUI) is given. The ASCII input file can be edited by advanced users who want to apply functionalities that are not (yet) supported by the GUI.

1.2 Manual version and revisions

A manual applies to a certain release of the related numerical program. This manual, version 2.14, applies to D-WAQ PART version 3.73.00, and PART-GUI version 2.26.30.

1.3 Typographical conventions

Throughout this manual, the following conventions help you to distinguish between different styles of text used to describe various aspects of the graphical user interface.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Module</strong></td>
<td>Title of a window or a sub-window are in given in <strong>bold</strong>.</td>
</tr>
<tr>
<td><strong>Project</strong></td>
<td>Sub-windows are displayed in the Module window and cannot be moved.</td>
</tr>
<tr>
<td></td>
<td>Windows can be moved independently from the Module window, such as the Visualisation Area window.</td>
</tr>
</tbody>
</table>
## Example

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Item from a menu, title of a push button or the name of a user interface input field. Upon selecting this item (click or in some cases double click with the left mouse button on it) a related action will be executed; in most cases it will result in displaying some other (sub-)window. In case of an input field you are supposed to enter input data of the required format and in the required domain.</td>
</tr>
<tr>
<td><code>&lt;tutorial\wave\swan-curvi&gt;</code> <code>&lt;siu.mdw&gt;</code></td>
<td>Directory names, filenames, and path names are expressed between angle brackets, <code>&lt; &gt;</code>. For Linux environments a forward slash (<code>/</code>) is used instead of the backward slash (<code>\</code>) for Windows environments.</td>
</tr>
<tr>
<td>&quot;27 08 1999&quot;</td>
<td>Data to be typed by you into the input fields are displayed between double quotes. Selections of menu items, option boxes etc. are described as such: for instance ‘select Save and go to the next window’.</td>
</tr>
<tr>
<td>delft3d-menu</td>
<td>Commands to be typed by you are given in the font Courier New, 10 points.</td>
</tr>
<tr>
<td>[m s$^{-1}$] [-]</td>
<td>Units are given between square brackets when used next to the formulae. Leaving them out might result in misinterpretation. Most units will be in SI notation. [m AD] stands for ‘meter Above Datum’, which denotes a level relative to the vertical reference system in the model.</td>
</tr>
</tbody>
</table>

### 1.4 Changes with respect to previous versions

<table>
<thead>
<tr>
<th>Version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.15</td>
<td>Update of Friesian Tidal Inlet tutorial model <code>&lt;*.mdp&gt;</code> file</td>
</tr>
<tr>
<td>2.14</td>
<td>Introduction of the <code>&lt;*.mdp&gt;</code> file</td>
</tr>
<tr>
<td>2.13</td>
<td>PART v3.72.00 and higher can handle thin dams from FLOW. Thus: In section 4.3 Remark removed to warn that thin dams defined in the FLOW model are not recognised in the PART model. In Chapter 5: data files <code>&lt;com-s33.*&gt;</code> replaced by <code>&lt;com-f35_part.*&gt;</code>, file <code>&lt;s33_oil.inp&gt;</code> replaced by <code>&lt;s35_oil.inp&gt;</code>; and <code>&lt;s33_tracer.inp&gt;</code> by <code>&lt;s35_tracer.inp&gt;</code>. Finally, figures updates.</td>
</tr>
</tbody>
</table>

continued on next page
2.12 MENU screens updated. Defining coupling input file and starting the coupling now separate MENU options. Remark added about incorrect interpolation of wind direction if the wind passes the North (0 degrees). Remark added to warn that thin dams defined in the FLOW model are not recognised in the PART model.

2.11 The most urgent change that was implemented in the model was the correction of the entrainment of oil in water. Because emulsification was considered essential for the simulation of the fate of oil, this process was also included. Since interaction of processes are significant, a number of feedback mechanisms were also implemented. After implementation, the changes in the specification of the modified compared with the standard oil module is as follows:

- Viscosity is now an input parameter and hence an oil characteristic, whilst the entrainment parameter (C0) is now calculated using a relationship that was derived from published data by Delvigne and Hulsen (1994).
- Viscosity is not a fixed parameter but a variable, depending on the evaporation and emulsification.
- Dispersion (entrainment) process is now consistent with the ADIOS model and independent of the grid.
- Emulsification is implemented in the model.
- The emulsification is initiated when the evaporated fraction exceeds a given fraction of the oil (input parameter by the user and oil type dependent).
- Emulsification is calculated by the increase in the water content of the oil and affects oil viscosity.
- Since emulsification affects oil viscosity, entrainment parameter (C0) is affected by a change in viscosity and the entrainment flux reduces when viscosity increases.
- Evaporation now affects oil viscosity and hence oil dispersion (entrainment). Evaporation is implemented using the analytical solution of a first order process.
- A volatile fraction can be specified. The non-volatile fraction will not be subject to evaporation.

2.11 Emulsification affects evaporation by using the water content of the oil as calculated during emulsification. When the water content reaches its defined maximum, evaporation ceases. All variables take account of the age of the particles and are being tracked for each particle individually, thus the processes are applied correctly for continuous discharges or several instantaneous discharges at different times.

2.11 section 4.12.2: The use of a Zoom grid is compulsory.

2.00 Improved layout of manual.
2 Introduction to D-WAQ PART

2.1 Short description of the program functionality

The PART module of Delft3D simulates transport and simple water quality processes by means of a particle tracking method using the (2 or 3-dimensional) flow data from the FLOW module. The tracks are followed in three dimensions over time, whereby a dynamic concentration distribution is obtained by calculating the mass of particles in the model grid cells.

The processes are assumed to be deterministic except for a random displacement of the particle at each time step. The particle tracking method is based on a random-walk method since the simulated behaviour is stochastic and the number of particles is limited (Rubinstein, 1981). (It is worth noting that D-WAQ PART is the only stochastic model in the whole Delft3D suite.)

Particle tracking allows water quality processes to be described in a detailed spatial pattern, resolving sub-grid concentration distributions. D-WAQ PART is best suited for studies over the mid-field range (200 m – 15 km) of instantaneous or continuous releases, simulation of a plume (for example oil-spill), and modelling of the transport of substances such as salt, bacteria, rhodamine dye, oil, BOD, or other conservative or decaying chemical substances (following first-order kinetics). For this reason, the D-WAQ PART module is often referred to as the Mid-field Water Quality module.

In D-WAQ PART, two modules are available:

- Tracer module: simulation of conservative or first order decaying substances.
- Oil spill module: simulation of oil spills with floating and dispersed oil fractions.

**Physical components**

The physical components of the D-WAQ PART model system include:

- the water system: a lake, estuary, harbour or river, possibly with open boundaries to other water systems. Tidal variations are included.
- discharges due to human activities that may be instantaneous and/or continuous;
- chemical substances like rhodamine dyes, salt, oil or suspended solids;
- time varying wind fields;
- settling and erosion of suspended matter;
- concentration dependent settling velocity.

Releases may be defined as instantaneous releases (e.g. dye releases) or continuous releases (e.g. from sewage outfalls).
Physical processes

Physical processes or phenomena that the model was designed to represent are:

- the dynamics of patches close to an outfall location;
- simple first-order decay processes like the decay of several fractions of oil;
- vertical dispersion for well-mixed systems;
- horizontal dispersion due to turbulence. According to turbulence theory this dispersion increases in time.
- the effects of time-varying wind fields on the patches;
- the effects of bottom-friction on the patches;
- the existence of a plume at the outfall (rather than a point-source) by starting the simulation from a circular plume with an estimated or field-measured radius.
- settling of particles, where a concentration dependent settling, subject to a minimum and maximum settling velocity, can be specified;
- transport and fate of spilled oil. Processes that are included in the oil module are: advection of floating oil by wind and currents, dispersion (entrainment in water) of oil induced by wind waves (depending on wind speed and oil characteristics), evaporation of floating oil, emulsification, decay, and sticking of oil to the coastline or seabed. Changes of oil properties (density, viscosity, water content) due to these processes are included in the oil module. Additional advection due to wind drag is implemented in 3D (for 2D the logarithmic profile of the current speed results in a similar wind driven transport), whilst in 3D a deflection angle is included to represent the Coriolis effect of wind induced advection due to waves.
- the model may be started from a known initial distribution of oil, e.g. a remote sensing image of an oil spill.

Applications

The model may be applied to various problems with the physical components, substances and processes described above. However, the time-scale of simulations is usually limited to a few weeks, in order to simulate accurately using a large number of particles. The model is very often applied for plume (outfall) studies with spatial scales of a few kilometres. In such cases, the hydrodynamic grid is often too coarse for other modelling techniques. The particle tracking method is not limited by the spatial resolution of the hydrodynamic database. Thus, detailed outfall studies can be done even within one computational grid cell covering a large area. A costly refinement of the grid in this area is not required.
**How does particle modelling work?**

The position of every individual particle can be influenced by:

- advection (transport by water flow)
- diffusion/dispersion (a random component)
- settling (including sedimentation/erosion characteristics)

In D-WAQ PART, every particle is subject to a random displacement. The distance of the displacement depends on the local dispersion and the time step in the model. The direction of the displacement is random. The method used is often referred to as the ‘random walk method’ or the ‘Monte Carlo method’.

The mass of a particle represents the amount of a substance attached to it. The mass of a particle can be influenced by:

- decay rate (first order decay)
- evaporation (of oil).

In D-WAQ PART, the position of every individual particle \((x, y\) and \(z\) co-ordinate) is known from its release until the end of the simulation. The position of a particle does not depend on the grid (size) used and so sub-grid concentration patterns can be calculated.

A release of a substance is distributed over the number of particles specified in the model run. For example, if a dye release of 10,000 particles is used to represent 100 grams of tracer, then each particle represents 0.01 g of tracer. In a continuous release the specified number of particles is distributed over the complete simulation time. That is, if a total number of 10,000 particles are released in 1 day, this is equivalent to 0.116 particles per second. Furthermore, if each particle is assigned 10 g of tracer, this is equivalent to a continuous release of 1.16 g/s.

The concentration of a substance is determined by the number of particles per unit volume. The volume used to calculate the concentrations is defined in one of two ways:

- The hydrodynamic segments (from the Delft3D-FLOW computation).
- Segments of a counting grid, the so-called zoom grid, which can be located in any position in the computational domain. The zoom grid defines a regular, rectangular grid in which the rectangles are usually much smaller than the hydrodynamic segments.

The model simply counts the number of particles present in each volume and calculates the corresponding concentration of each substance.

### 2.2 Specification of the program package

This User Manual describes the use of the Graphical User Interface (PART-GUI) for the computational model D-WAQ PART of the Delft3D suite. The PART-GUI enables you to input and to retrieve data necessary for preparation and execution of a modelling run.

The manual also describes input and output files generated by PART-GUI and D-WAQ PART.
2.3 Installing the program

The installation of the Delft3D suite is described in the Installation Manual that is supplied with the software.

2.4 Error checking

The syntax of the input file is checked by the computational core of D-WAQ PART. Syntax errors cannot occur if you use the PART-GUI. However, if you edit the input files directly, syntax errors may occur and you are responsible for tracing the origin of the error.

The program may stop without an error message on the screen. Error messages are always given in the report file <*.out> of the simulation. Looking for the word ‘ERROR’ (capital letters) in this report file can be very useful.

2.5 Particle tracking module within Delft3D

PART-GUI enables you to interact with the mid-field water quality model D-WAQ PART. The other GUI modules like FLOW-GUI, WAQ-GUI, etc. enable you to interact with other modules in the Delft3D modelling system. These interactions include the input and retrieval of data that is necessary for preparation, execution and post-processing of a modelling run.

![Software architecture around the particle tracking module](image)

Figure 2.2: Software architecture around the particle tracking module

Figure 2.2 shows a part of the Delft3D suite software structure and the location of the Particle Tracking module with respect to the other Delft3D modules (e.g. Hydrodynamics, Water Quality, etc.). The most important components in this figure are:

- coupling module
- graphical user interface (PART-GUI)
- particle tracking computational module (D-WAQ PART)
- GPP and QUICKPLOT modules for visualisation of results

Descriptions of the other Delft3D modules can be found in the associated User Manuals Delft3D-FLOW UM (2013); D-WAQ UM (2013); WAVE UM (2013); GPP UM (2013).
2.6 Input data files

Execution of the D-WAQ PART computational module depends on the presence of a number of D-WAQ PART input files. PART-GUI enables you to input data that are necessary for writing an input file and to retrieve data from existing input files. A D-WAQ PART scenario is defined by the <*.mdp> file (mdp: Master Definition Part), the corresponding <*.inp> and the <*.hyd> file. For each new scenario the files <*.mdp> and <*.inp> are created by PART-GUI. The files <*.mdp> and <*.inp> are required when opening an existing scenario. The <*.hyd> file is created by the Coupling module.

The input data are divided in data groups: Description, Hydrodynamics, Substances, Time Frame, Initial Condition, Numerical Parameters, Instantaneous Releases, Continuous Releases, Process Parameters, Observation Points and Output Options.

Coupling module

The coupling module provides D-WAQ PART with all of the necessary files from the hydrodynamic (Delft3D-FLOW) modelling results. The hydrodynamic results are described in a <*.hyd> file and the corresponding data is given in the associated grid files (<*.lga>, <*.lgt>, <*.cco>), volumes file (<*.vol>) and flows file (<*.flo>).

2.7 Limitations in PART-GUI

In this section the list of (known) limitations of PART-GUI is described. Most of them have to do with a maximum number of substances, observations points etc. Please take them into account while using the PART-GUI.

Table 2.1: Limitations of the PART-GUI

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Maximum number of substances (oil counts as 3 substances)</td>
<td>90</td>
</tr>
<tr>
<td>2</td>
<td>Maximum number of continuous releases (note: number of instantaneous releases is unlimited)</td>
<td>25</td>
</tr>
<tr>
<td>3</td>
<td>Maximum number of columns in (any) GUI table</td>
<td>70</td>
</tr>
<tr>
<td>4</td>
<td>Maximum number of oil types (oil counts as “1”)</td>
<td>30</td>
</tr>
<tr>
<td>5</td>
<td>Maximum number of time breakpoints in GUI table</td>
<td>1 000</td>
</tr>
<tr>
<td>6</td>
<td>Maximum number of layers in case of PLO output</td>
<td>100</td>
</tr>
</tbody>
</table>
3 Getting started

3.1 Starting Delft3D

The Delft3D suite is a range of modules that can be run independently of one another. The main menu of Delft3D provides access to each of the main modules. Delft3D-MENU can be started either:

- In Microsoft®Windows, select Delft3D in the Programs Menu or click on the Delft3D icon on the desktop.
- On Linux/UNIX, type `delft3d-menu` on the command line.

The main window of Delft3D-MENU is shown in Figure 3.1.

3.2 Particle tracking module

The PART module is started by selecting `Start` in the main menu. The Particle tracking selection menu is shown in Figure 3.2.

From the Particle tracking menu, it is possible to start the Coupling module, start the graphical user interface (PART-GUI), begin computations with D-WAQ PART, view output report files (ASCII) and to visualise the results using GPP or Delft3D-QUICKPLOT.

3.3 Change working directory

It is also possible to select and/or change the default working directory in which the input are located and to which the output files will be written.

The Select working directory button opens a window in which the current working directory is identified as shown in Figure 3.3.

The current working directory can be changed by browsing to and entering the preferred directory using the window of Figure 3.3 and confirming with `OK`. You have to ensure that you have write permission in the selected directory.

![Figure 3.1: Main window of Delft3D-MENU](image-url)
Figure 3.2: Particle tracking menu in Delft3D-MENU

Figure 3.3: Select working directory window
3.4 Coupling module

3.4.1 Introduction

The transport of substances is based on the hydrodynamic results from a Delft3D-FLOW computation. Delft3D-FLOW generates a so-called communication file, consisting of a data file and a definition file. The names of these files are `<com-*.dat>` and `<com-*.def>` respectively, where `*` indicates a run identification of the Delft3D-FLOW simulation. These files need to be converted to a so-called hyd-file, that can be used by D-WAQ PART. But it is preferred now use the option to let Delft3D-FLOW write the hyd file directly (and skip the use of the coupling program) by switching on 'Export WAQ input' in the output section of Delft3D-FLOW.

The communication or hyd file should encompass a representative period of the hydrodynamic results with a sufficient time-step resolution. Examples of a representative period would be a single tide (e.g. ~12.5 hours) or a spring-neap cycle (e.g. ~15 days). The time-step resolution must be selected to sufficiently describe the variations in the hydrodynamics. For example, the time step for a repeating 12 hour tidal cycle should not be greater than one hour.

D-WAQ PART allows water quality processes to be described in a detailed spatial pattern and can resolve sub-grid concentration distributions. The velocity field at the location of each particle is interpolated between the velocity values given at each grid cell in the hydrodynamic result file.

The data required to execute a D-WAQ PART simulation can be extracted from the hydrodynamic communication file by the coupling module. In the coupling module, you must define the:

- **start time** for the coupled hydrodynamics
- **stop time** for the coupled hydrodynamics
- **time step** for the coupled hydrodynamics
- **vertical aggregation** of hydrodynamic results (if required)

But it is preferred now use the option to let Delft3D-FLOW write the hyd file directly by switching on 'Export WAQ input' in the output section of Delft3D-FLOW. Use the second Output panel to the start time, stop time, time step and optionally the vertical aggregation.

Remarks:

- The coupling module is common to both D-WAQ PART and D-Water Quality. For this reason, some of the options available in the coupling module are not applicable to a D-WAQ PART simulation.
- When you need a coupling from a domain decomposition hydrodynamic simulation you have to define the input for each domain separately when using the com files (not needed when using Export WAQ input).
- When you run Delft3D-FLOW with MPI-based parallel, you cannot use the communication files. You will have to switch on the Export WAQ input in the output settings. Use 'DD Start' in the Water Quality or PART coupling menu with the MPI-based parallel option to merge the output into one domain for D-Water Quality or D-WAQ PART.
- Horizontal aggregation is not allowed when using D-WAQ PART, only vertical aggregation.
- D-WAQ PART cannot work with Z-layer models because it assumes a uniform and constant over time relative thickness of the vertical layers as stated in the hyd-file. For Z-layer models, this not true. It also doesn’t check whether segments are below the bed, so particles can end up below the bed.
Rewinding hydrodynamic results

D-WAQ PART allows you to extend the particle tracking simulation beyond the period after coupling the communication file. When D-WAQ PART reaches the end of the period in the coupled hydrodynamics files, it will rewind the (coupled) hydrodynamic files and repeat them (see Figure 3.4) until it reaches the end of the D-WAQ PART simulation.

Remark:
- As D-WAQ PART will rewind the (coupled) hydrodynamic result, it is important that the start and the end of the representative period are similar. In Figure 3.4, the water level is the same at the start and the end of this period. D-WAQ PART does not check this closure error. You should check this yourself by plotting the change in water level due to a rewind.

Aggregation

Hydrodynamic modelling usually requires a more detailed schematisation or grid than water quality modelling. Therefore, it is often desirable to reduce the number of computational cells in a water quality simulation to reduce computation time and the size of the output files. This process is called aggregation. In D-WAQ PART, aggregation is only allowed in the vertical direction (see Figure 3.5).

Remark:
- Aggregation of the hydrodynamic results will inevitably result in a loss of information and should be avoided if possible in D-WAQ PART simulations.
Figure 3.5: Principle of vertical aggregation where 10 layers in the hydrodynamic simulation are aggregated to 5 layers in the water quality simulation.

Figure 3.6: Hydrodynamic coupling selection window.
3.4.2 Coupling GUI

If you have let Delft3D-FLOW write the hyd-file directly by switching on ‘Export WAQ input’, you can skip the rest of this section and go to section 3.5. Otherwise you will have to couple a hydrodynamic result first. Select Coupling from the Particle tracking window (see Figure 3.2). The Hydrodynamic coupling selection window is displayed, in which you can create or edit the coupling input and start the coupling, see Figure 3.6.

Select Define input. The COUP-GUI window is opened as shown in Figure 3.7.

Only three data groups are selectable: Description, Hydrodynamics and Dispersion.

**Description**

Clicking Description opens a screen in which you can enter three lines of text. The lines can be used to describe the coupling/aggregation. The maximum length of each of the lines is 40 characters.
Hydrodynamics

Selecting Hydrodynamics opens the sub-window as shown in Figure 3.8.

First, you must select a hydrodynamics communication file by clicking Com-file under Hydrodynamics and grid frame. A file browser window is opened and you can navigate and select the appropriate <com-*.dat> file (the associated <com-*.def> file is required to exist in the same directory). After selecting the appropriate communication file, the times (start time, stop time and time step) stored in the communication file are displayed. Next you must select appropriate start and stop times and a time step for the coupled hydrodynamic results. The start and stop times and the time step of the hydrodynamic results stored in the communication file are shown next to the appropriate edit field.

The Start time, Stop time and Time step of the coupled hydrodynamics have to satisfy the following conditions:

- The start time of the coupled hydrodynamics has to be equal to or later than the start time in the communication file.
- The start time of the coupled hydrodynamics has to be before the stop time in the communication file.
- The stop time of the coupled hydrodynamics has to be before or equal to the stop time in the communication file.
- The stop time of the coupled hydrodynamics has to be later than the start time in the communication file.
- The stop time in the coupled hydrodynamics has to be later than the start time in the coupled hydrodynamics.
- The time step in the coupled hydrodynamics file has to be equal to an integer multiple of the time step in the communication file. For example, if the time step in the communication file is 30 minutes, allowable time steps in the coupled hydrodynamics are 30 minutes, 1 hour, 90 minutes, 2 hours, etc.
The total time between the start time and the stop time in the coupled hydrodynamics has to be an integer multiple of the time step in the coupled hydrodynamics.

To vertically aggregate the layers, click *Edit layers*. The *Layer editor* window will open, listing the number of layers in the hydrodynamic simulation. By default, each layer in the water quality model (using the coupled hydrodynamics) is set equal to one layer in the hydrodynamic simulation. Figure 3.9 shows the *Layer editor* for a hydrodynamic simulation with 5 layers. By entering an integer number in one of the input boxes, you indicate the number of hydrodynamic layers that have to be included in the specific water quality layer. In Figure 3.9 (right hand side), the first layer in the water quality simulation contains the first and second hydrodynamic layers. The second layer in the water quality simulation contains the third and fourth hydrodynamic layers. The third layer in the water quality simulation contains the fifth hydrodynamic layer. Entering a number greater than 1, means that water quality layers will be removed from the bottom (note that layer 1 is the surface layer). Lowering the number in a text box, means that water quality layers will be added at the bottom. The sum of the hydrodynamic layers will always be equal to the original number of layers.

![Layer editor example](image)

*Figure 3.9: Vertical aggregation using the Layer editor*

The left screen shows the original 10 hydrodynamic layers. The right screen shows a vertical aggregation into 5 layers that will be applied in the D-WAQ PART simulation.

**Remark:**

- Zero cannot be entered in any edit field. If the number entered is higher than the number of hydrodynamic layers available, a warning will be given and the number will be truncated to the maximum allowed. A 2D hydrodynamic simulation cannot be aggregated vertically.

**Dispersion (not applicable for D-WAQ PART)**

Clicking *Dispersion* opens a sub-window that has options that are only applicable for a D-Water Quality simulation. This window should not be used for a D-WAQ PART simulation.

### 3.4.3 Running the coupling module

After defining the desired coupling of the hydrodynamic file `<com-* .dat>`, you must save the coupled hydrodynamics file `<*.hyd>` by selecting *File → Save or File → Save As...* from the
Figure 3.10: Main menu of PART-GUI

menu bar. The default name of the coupled hydrodynamics file is <com-*.hyd>. Leave the COUP-GUI, File → Exit; you will be back in the Hydrodynamic coupling selection window, Figure 3.6.

Remark:
- The <*.hyd> file and the coupled hydrodynamics are always saved in the working directory.

Select Start to perform the hydrodynamic coupling. Information about the coupling will be displayed in a window. Close this window by selecting File → Exit.

The same information on the coupling is written to the <coupntf.out> file in the working directory. You should examine this file: select Return to go back to the Particle tracking selection window, Figure 3.2. Select Reports and next Coupling to view the report file from the hydrodynamic coupling.

3.5 Starting PART-GUI

PART-GUI is started by selecting the menu item Define input from the Particle tracking menu. The main menu of PART-GUI is shown in Figure 3.10.

The menu bar at the top of the screen provides options for opening and saving files, for editing tables, for visualisation of the grid layout and for obtaining help.
3.5.1 Accessing the data groups

A data group is accessed by clicking on the corresponding button on the left-hand side of the PART-GUI window. For example, clicking Hydrodynamics opens the data group window as shown in Figure 3.11.

Pressing other buttons in the main window will change the window to the appropriate settings for each of the data groups. Changes made in any of the data group windows will be retained by PART-GUI. You will be prompted to save this data in an mdp-file <*.mdp>, with a reference to the input file <*.inp>, when the PART-GUI session is ended.

3.5.2 Visualisation Area window

In PART-GUI, the Visualisation Area window is used to visualise the layout of the hydrodynamic grid and to assist you in defining the Zoom Grid Output in the Output Options. Also, observation points, instantaneous and continuous releases can be added using this tool. The Visualisation Area window can be started by selecting View → Visualisation Area in the menu bar as shown in Figure 3.12.

The Visualisation Area window then appears as shown in Figure 3.13. The hydrodynamic computational grid is shown as black lines and the outline of the Zoom Grid Output is shown as a red rectangle. The use of the Visualisation Area window to define the Zoom Grid Output is described in the Output Options Data Group.
3.5.3 Editing tables

In some data groups in PART-GUI, it is necessary to input data in tabular form (e.g. time series data). The Table option in the menu bar allows you to Insert row, Copy row, Delete row or Copy value as shown in Figure 3.14.

![Figure 3.14: Table editing options in the PART-GUI main menu bar](image)

3.5.4 Saving a D-WAQ PART input file

In order to preserve changes and additions to the data groups, it is necessary to save the data defined in the data groups in an input data file, <*.mdp>.

You can save the input by clicking menu item File → Save (or Save as…) in the menu bar as shown in Figure 3.15. The file <runid.mdp> will be saved by PART-GUI and in the same directory the file <runid.inp> will be written.
3.6 Quitting the program

A PART-GUI session is ended by selecting File → Exit from the menu bar as shown in Figure 3.16. The program will first ask whether you wish to save the $\textit{<*.mdp>}$ file before proceeding as shown in Figure 3.17.

After quitting PART-GUI, you are returned to the Particle tracking window. You can then exit Delft3D entirely by selecting Return and next Exit.
4 Graphical User Interface

4.1 General

4.1.1 Initial conditions
D-WAQ PART assumes that there are initially no particles present in the computational domain, except for the oil module where initial oil patches can be specified.

4.1.2 Boundary conditions
There are no boundary conditions. Particles which are transported out of the model domain cannot return.

4.1.3 Co-ordinate system
Co-ordinates must be given in the Cartesian (metric) system.

4.1.4 Data groups
The data for a particle tracking scenario are grouped into the following data groups: Description, Hydrodynamics, Substances, Time Frame, Initial Condition, Numerical Parameters, Instantaneous Releases, Continuous Releases, Process Parameters, Observation Points and Output Options. Each data group is described in detail in the following sections.

The GUI has been set up in such a way that normally you should work through the data groups from top to bottom.

4.2 Description
Selecting the Data Group Description opens a window with edit fields as shown in Figure 4.1. This allows you to add or change text in the input file that will assist in identifying and describing the scenario.

**Domain:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Lower limit</th>
<th>Upper limit</th>
<th>Default</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line 1</td>
<td>0 characters</td>
<td>40 characters</td>
<td>blank</td>
<td></td>
</tr>
<tr>
<td>Line 2</td>
<td>0 characters</td>
<td>40 characters</td>
<td>blank</td>
<td></td>
</tr>
<tr>
<td>Line 3</td>
<td>0 characters</td>
<td>40 characters</td>
<td>blank</td>
<td></td>
</tr>
</tbody>
</table>
4.3 Hydrodynamics

Selecting the Data Group *Hydrodynamics* opens a window as shown in Figure 4.2.

A particle tracking scenario requires the results from an existing hydrodynamic scenario. The files required for D-WAQ PART are extracted from a Delft3D-FLOW result file by the coupling module. The coupling module creates a `<*.hyd>` file that contains information about the hydrodynamic scenario and the associated hydrodynamic files (flows, volumes and grid).

To open hydrodynamic results, click *Select File*. This opens a standard navigation window for file selection as shown in Figure 4.3. After selecting the required `<*.hyd>` file, the names of the relevant hydrodynamic files appear in the window as shown in Figure 4.2. These names can only be changed by selecting a different hydrodynamic scenario file.

A hydrodynamic scenario file may be located in another directory other than the working directory.
4.3.1 Number of layers in hydrodynamics

The number of layers given in the hydrodynamic scenario file will determine whether the D-WAQ PART simulation will be carried out as a 3-dimensional (3D) simulation or as a 2-dimensional, depth-averaged (2D) simulation. If the hydrodynamic results are from a 2D hydrodynamic simulation then only one layer will be present in the hydrodynamic scenario file and D-WAQ PART will also be a 2D simulation.

If the hydrodynamic results are from a 3D hydrodynamic simulation, the D-WAQ PART simulation can either be 2D or 3D, depending on the number of layers aggregated by you in the Coupling module.
### 4.4 Substances

Selecting the Data Group *Substances* opens a window as shown in Figure 4.4.

Before defining a specific substance in D-WAQ PART, a *Type of model* must be selected. You must select either *Tracer* or *Oil*.

- **Tracer**: conservative substances (e.g. salt, dyes), bacteria or other decaying and settling substances (see Figure 4.4).
- **Oil**: for modelling the spreading and fate of oil spills (see Figure 4.6).

The default option is *Tracer*.

Only one *Type of model* can be selected for a D-WAQ PART simulation. However, it is possible to simulate oil together with a tracer by selecting model type *Oil* and then adding a specific tracer substance with the tick at *Oil fraction* removed. A tracer defined in this way (thus in combination with an oil substance) can only be released at the water surface in the same way as an oil spill.

#### 4.4.1 Tracers

For the selected model type *Tracer*, a default substance is given automatically with the name “tracer” as shown in Figure 4.4.

**To add a substance:**

- Click *Add*; a substance named (new) is created.
- Type the name of the substance in the name box and confirm by clicking outside the name box, but inside the GUI. The name must be a non-blank name.

**To rename a substance:**

- Select the substance in the list.
- Edit the name of the substance in the name box and confirm by clicking outside the name box, but inside the GUI. The name must be a non-blank name.

**To delete a substance:**

- Select the substance in the list.
- Click *Delete*.
- Confirm that the substance and its related data are to be deleted by selecting *Yes* in the confirmation window as shown in Figure 4.5.
- The substance is then erased from the list.

D-WAQ PART requires that at least one substance must be defined.

For Tracer calculations, the units of mass are given in [kg] and the units of concentration in [kg/m$^3$].
**4.4.2 Oil**

If the *Type of model* is selected as *Oil*, the **Substances** window changes as shown in Figure 4.6.

The default substance name is given as “Ekofisk”. An additional check box appears to set the substance to oil or to a tracer. Default the *Oil fraction* check box is ticked off. If the tick is removed, the substance will behave as a tracer. However, the tracer in this case can only be released at the water surface in the same way as an oil spill.

*Oil* substances can be added, renamed or deleted in the same way as described earlier for *Tracer*.

For an oil fraction, the units of mass are given in [kg]. For the computations, D-WAQ PART assumes that an oil fraction consists of three phases. The units of concentration of an oil fraction depend on the oil phase:

- Floating Oil; a thin layer of oil floating on top of the water column; [kg/m\(^2\)]
Dispersed (Entrained) Oil; oil droplets entrained in the water column; [kg/m$^3$]

Sticking Oil; oil that sticks to the land or the bed and is no longer transported; [kg/m$^2$]

When an oil fraction is initially released, it is assumed to consist entirely of floating oil. During the computation, floating oil may be converted to dispersed (entrained) oil or to sticking oil. The conversion process is controlled by parameters that must be defined under the Data Group Process Parameters.

**Domain:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Lower limit</th>
<th>Upper limit</th>
<th>Default</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of substance</td>
<td>1 character (non-blank)</td>
<td>14 characters</td>
<td>Ekofisk</td>
<td></td>
</tr>
<tr>
<td>Oil fraction</td>
<td>check box for Oil fraction or not an Oil fraction</td>
<td></td>
<td>Oil fraction</td>
<td></td>
</tr>
</tbody>
</table>

**Restrictions:**

- PART-GUI will allow the definition of a maximum of 90 substances. Each oil type represents 3 simulated substances (i.e. floating, entrained and sticking oil). It is therefore possible to define a maximum of 30 oil types.
- If you want to use not an Oil fraction substances together with Oil fraction substances, then you have to define first ALL Oil fraction substances.

### 4.5 Time frame

Selecting the Data Group Time Frame opens a window as shown in Figure 4.7.

In this data group, you must specify:

- the simulation stop time
- the time step
4.5.1 Date-time format

All times are given in the date-time format “dd mm yyyy hh mm ss” in which:

- dd mm yyyy: date in day, month, year format
- hh mm ss: time of day in hours, minutes, seconds format.

4.5.2 Start time

The simulation start time is equal to the start time of the hydrodynamic scenario (after coupling). The value is read from the hydrodynamic result file and cannot be changed.

4.5.3 Stop time

The simulation stop time given in the Stop time field must be greater than the simulation start time value. If the simulation stop time is greater than the stop time of the hydrodynamic scenario (after coupling), the hydrodynamic results are repeated as if the flow was periodic. In this case, you should ensure that the hydrodynamic results have been stored (or coupled) over a cyclic period and that there is no major discontinuity between the hydrodynamic results in the first time step and the last time step of the cycle.

4.5.4 Time step

The time step given in the Time step field for the particle tracking computation must be less than or equal to the time step in the hydrodynamic scenario result file. Furthermore, to avoid interpolation errors, the particle tracking time step must be chosen such that it is an integer fraction of the hydrodynamic scenario time step.

4.5.5 Reference time input

For the simulation, all time instances and time-series are expressed in the number of time steps relative to the reference time input. To ensure consistency, the reference time input for the particle tracking simulation must be equal to the reference time input of the hydrodynamic scenario. This value is read from the hydrodynamics result file by the coupling module and cannot be changed.
4.6 Initial condition

Initial conditions can only be specified when the oil module is selected. Then the Initial Condition Data Group will be available. Selection of this data group opens a window as shown in Figure 4.8.

If you select to specify the initial condition, then a navigation window will open that enables you to select the initial condition file (*.ini). See section A.6 for details of the *.ini file.

It should be noted that the number of particles specified in the initial condition file is in addition to the number of particles associated with instantaneous and continuous releases.

4.7 Numerical parameters

Selecting the Numerical Parameters Data Group opens a window as shown in Figure 4.9.

In this data group you must specify:

- the number of particles per release
- a vertical dispersion option
- a scaling factor for the vertical dispersion coefficient

4.7.1 Number of particles

The number of particles per release used in the simulation is important for the accuracy of the computed results. Due to the stochastic nature of the dispersion process, the simulation requires a large number of particles to obtain the best results. In general, the accuracy varies with the square-root of the number of particles.

The number of particles required will depend on several factors, namely:

- the length of the simulation
- the expected extent of spreading of the particles
- the size of the cells in the computational grid or the zoom window
- the number of releases
- the number of layers used in vertical direction, and the accuracy required over vertical direction
Furthermore, continuous releases usually require more particles than instantaneous releases.

The accuracy of a simulation is often expressed as the smallest concentration that can be represented by a single particle in a computational cell. The minimum concentration level that can be represented by a particle is the mass of the particle divided by the volume of the cell in which the particle is located.

\[ C_{\text{min}} = \frac{m_{\text{particle}}}{A_{\text{cell}} \times h_{\text{layer}}} = \frac{M_{\text{total}}}{N_{\text{total}} \times A_{\text{cell}} \times h_{\text{layer}}} \]  \hspace{1cm} (4.1)

where:
- \( C_{\text{min}} \) minimum concentration resolution \([\text{kg/m}^3]\)
- \( m_{\text{particle}} \) mass per particle \([\text{kg}]\)
- \( A_{\text{cell}} \) surface area of computational (or zoom window) cell \([\text{m}^2]\)
- \( h_{\text{layer}} \) local layer thickness \([\text{m}]\)
- \( N_{\text{total}} \) total number of particles in the release \([-]\)
- \( M_{\text{total}} \) total mass of release \([\text{kg}]\)

**Example**

The above relationship can be used to estimate the required number of particles for a given simulation. Consider an example in which you wish to simulate the release of a total of 10 000 kg of substance. The smallest grid cell in the computational domain within the area of interest has a surface area of 200 m\(^2\) with a minimum layer thickness of 4 m. It is required that the simulation should be able to resolve concentrations of at least 0.001 kg/m\(^3\). The minimum total number of particles required for this release would therefore be \( N \geq \frac{10\,000}{(0.001 \cdot 200 \cdot 4)} = 12\,500 \) particles.

If you require even more resolution of the concentration level (i.e. even smaller minimum concentration level) then the mass per particle must be reduced. This is usually done by increasing the number of particles for a given release. In practice the best compromise between accuracy (e.g. resolution) and performance (e.g. speed of computation) is usually found by trial and error.

### 4.7.2 Vertical dispersion

You must select a vertical dispersion option by clicking on the appropriate radio button. The options are:

- **Depth averaged algebraic**: In this option, the vertical dispersion is assumed to be constant over the depth. The value is approximated by an analytical function described in Chapter 6. The analytical function calculates the vertical dispersion coefficient as a function of the total depth. In this case, therefore, the vertical dispersion coefficient may vary with location if the total depth is also varying.
- **Constant dispersion**: In this option, the vertical dispersion coefficient is taken to be constant in time and space. In this case, you must specify a (constant) value for the vertical dispersion coefficient.

A vertical dispersion *Scale factor* must be given in the edit field. The vertical dispersion coefficient defined above is multiplied by this scale factor for the simulation. The default value is 1.0.
4.8 Instantaneous releases

In the Data Group Instantaneous Releases you can specify the name and co-ordinates of the instantaneous release location, the initial radius of the release and the number of particles to be released. The mass of substance released at each release location and the release time are defined in the Release tables for instantaneous releases window.

Selecting the Data Group Instantaneous Releases opens a window as shown in Figure 4.10.

This window belongs to tracer substances. For oil substances the window is slightly different, see further on.

To add an instantaneous release location:

- Press Add; an instantaneous release named (new) is created.
- Type the name of the release location in the name box and confirm by pressing Enter on the keyboard. The name must be a non-blank name.
- Use the Visualisation Area window or the keyboard to specify the $x$ co-ordinate and the $y$ co-ordinate of the instantaneous release location.
- Specify the vertical position of the instantaneous release location in one of two ways:

---

**Figure 4.10:** Instantaneous Releases Data Group for tracer substances

<table>
<thead>
<tr>
<th>Domain:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parameter</strong></td>
</tr>
<tr>
<td>Number of particles</td>
</tr>
<tr>
<td>Vertical dispersion option</td>
</tr>
<tr>
<td>Dispersion coefficient</td>
</tr>
<tr>
<td>Scale factor</td>
</tr>
</tbody>
</table>

1) It is not recommended to use less than 100 particles per substance.
2) If Particle tracks is selected in the Output Options Data Group, the number of particles should be less than 1000.
Graphical User Interface

Figure 4.11: Release tables for instantaneous releases window for defining release time and mass of release

- for 2D models; as a percentage of the local water depth (0 % = surface; 100 % = bottom);
- for 3D models; as a layer number in which the release is uniformly distributed over the entire layer (layer 1 = surface layer)

- Specify the number of particles to be used for this release.
- Specify the radius of the instantaneous release location.
- Press Release Tables to open the sub-window shown in Figure 4.11.
- Specify the release time.
- Specify the mass of each of the substances to be released as defined in the Data Group Substances.

To delete an instantaneous release location:

- Select the instantaneous release location in the list.
- Click Delete.
- Confirm that the release and its related data are to be deleted by selecting Yes in the confirmation window.
- The instantaneous release is then deleted from the list.

4.8.1 Co-ordinates of instantaneous release location

The horizontal position of the instantaneous release location is given in Cartesian co-ordinates defined by an \( x \) co-ordinate and a \( y \) co-ordinate. The co-ordinates of the instantaneous release location must be within the computational grid.

The definition of the vertical position of the instantaneous release location will depend on whether a 2D or 3D simulation is being defined.

- For 2D simulations, there is only one (horizontal) layer in the model and the vertical position of the instantaneous release location must be defined as a percentage of the depth below the water surface. That is, 0 % represents a surface release and 100 % represents a release at the bottom of the water column.
- For 3D simulations, the released particles are distributed uniformly over the layer in which the instantaneous release is defined. You must therefore give the layer number in which the release takes place. Layer 1 represents the surface layer and is the default value.

For oil releases, the substance to be released is floating oil and therefore the particles can
only be released at the surface. For 2D models, the floating oil must be released at 0 % of the depth below the surface. For 3D models, the floating oil must be released in Layer 1 (surface layer). Therefore, if the oil module has been selected in the Data Group Substances, the vertical position of the instantaneous release location is fixed and cannot be altered by you, see Figure 5.13.

4.8.2 Particles used

You must define how many particles are to be used for each instantaneous release. The number of particles used per release will depend on the required resolution of the computation. The number of particles used for each release is defined as a percentage of the number of particles given in the Data Group Numerical Parameters. For example, if the number of particles per release was defined as 10 000 in the Numerical Parameters Data Group and you have defined two releases each using 100 % of the particles, then the total number of particles that will be used in the simulation will be $2 \times 10 000 = 20 000$ particles.

4.8.3 Radius of instantaneous release

D-WAQ PART can be used for studying the spread of substances in the mid-field region of interest. D-WAQ PART does not model the initial spreading and mixing (i.e. near-field) phenomena that occur as a discharge leaves a nozzle or outlet pipe and enters the ambient waters. The initial spreading and mixing occurs very quickly and quite close to the outlet point. In order to incorporate the effect of initial spreading in a D-WAQ PART simulation, it is possible to define a radius of the instantaneous release. The particles in the instantaneous release are then spread uniformly around the circumference of a circle with this radius, centred at the release location.

For oil spills, the initial radius of the instantaneous release may be determined by the gravitational surface spreading that occurs very quickly after oil is released at the water surface, see Chapter 6. If the oil module has been selected in the Substances Data Group, it is possible to allow D-WAQ PART to calculate this initial radius by selecting the appropriate option in the Data Group Instantaneous Releases. The radius is then calculated from a user-defined density of oil [kg/m$^3$]. You can also specify a user-defined radius, see Figure 4.12.

For the oil module it is recommended to use the calculated radius because this will allow the specification of the oil density. If oil density is not provided a value of 890 kg/m$^3$ is assumed.

4.8.4 Release time and mass of release

The release time and the mass of the instantaneous release are defined in the Release tables for instantaneous releases window as shown in Figure 4.11. The (instantaneous) Release time must be given in date-time format. The Substances table contains one column for each substance defined in the Data Group Substances. You must specify the total mass of each of the substances released in kg.
Figure 4.12: Instantaneous Releases Data Group for oil substances

**Domain:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Lower limit</th>
<th>Upper limit</th>
<th>Default</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of instantaneous release</td>
<td>1 character</td>
<td>20 characters</td>
<td>(new)</td>
<td>-</td>
</tr>
<tr>
<td>x co-ordinate</td>
<td>-</td>
<td>-</td>
<td>0</td>
<td>m</td>
</tr>
<tr>
<td>y co-ordinate</td>
<td>-</td>
<td>-</td>
<td>0</td>
<td>m</td>
</tr>
<tr>
<td>Layer number (for 3D only)</td>
<td>1</td>
<td>no. of layers</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td>Percentage of depth below surface (for 2D only)</td>
<td>0 (surface)</td>
<td>100 (bottom)</td>
<td>0</td>
<td>%</td>
</tr>
<tr>
<td>Particles used</td>
<td>0</td>
<td>100</td>
<td>100</td>
<td>%</td>
</tr>
<tr>
<td>Radius of release option</td>
<td>user-defined</td>
<td>calculated (only for oil)</td>
<td>user-defined</td>
<td></td>
</tr>
<tr>
<td>Radius of release</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>m</td>
</tr>
<tr>
<td>Release time</td>
<td>start time</td>
<td>stop time</td>
<td>start time</td>
<td>date-time format</td>
</tr>
<tr>
<td>Amount of substance released</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>kg</td>
</tr>
</tbody>
</table>
4.9 Continuous releases

In the Data Group Continuous Releases you can specify the name and co-ordinates of the continuous release location, the initial radius of the release and the number of particles to be released. The discharge rate of the release, the concentration of the substance released and the release time are defined in the Release tables for continuous releases window.

Selecting the Data Group Continuous Releases opens a window as shown in Figure 4.13.

This window belongs to tracer substances. For oil substances the window is slightly different, see further on.

To add a continuous release location:

- Click Add; a continuous release named (new) is created.
- Type the name of the location in the name box and confirm by pressing Enter on the keyboard. The name must be a non-blank name.
- Use the Visualisation Area window or the keyboard to specify the $x$ co-ordinate and the $y$ co-ordinate of the continuous release location.
- Specify the vertical position of the continuous release location in one of two ways:
  a. for 2D models; as a percentage of the local water depth (0 % = surface; 100 % = bottom);
  b. for 3D models; as a layer number in which the release is uniformly distributed over the entire layer (layer 1 = surface layer)
- Specify the number of particles to be used for this release.
- Specify the radius of the continuous release.
- Click Release Tables to open the sub-window shown in Figure 4.14.
- Specify the time-series of discharge for each release.
- Select a radio button to indicate whether Linear or Block interpolation is to be used in the time-series table.
- Specify the concentration of each of the substances in the continuous release as defined in the Substances Data Group.

To delete a continuous release location:

- Select the continuous release location in the list.
- Click Delete.
Confirm that the release and its related data are to be deleted by selecting Yes in the confirmation window.
The continuous release is then deleted from the list.

4.9.1 Co-ordinates of continuous release location

The horizontal position of the continuous release location is given in Cartesian co-ordinates defined by an $x$ co-ordinate and a $y$ co-ordinate. The co-ordinates of the continuous release location must be within the computational grid.

The definition of the vertical position of the continuous release location will depend on whether a 2D or 3D simulation is being defined.

- For 2D simulations, there is only one (horizontal) layer in the model and the vertical position of the continuous release location must be defined as a percentage of the depth below the water surface. That is, 0 % represents a surface release and 100 % represents a release at the bottom of the water column.
- For 3D simulations, the released particles are distributed uniformly over the layer in which the continuous release is defined. You must therefore give the layer number in which the release takes place. Layer 1 represents the surface layer and is the default value.

For oil releases, the substance to be released is floating oil and therefore the particles can only be released at the surface. For 2D models, the floating oil must be released at 0 % of the depth below the surface. For 3D models, the floating oil must be released in Layer 1 (surface layer). Therefore, if the oil module has been selected in the Data Group Substances, the vertical position of the continuous release location is fixed and cannot be altered by you.
4.9.2 Particles used

You must define how many particles are to be used for each continuous release. The number of particles used per release will depend on the required resolution of the computation. The number of particles used for each release is defined as a percentage of the number of particles given in the Data Group *Numerical Parameters*. For example, if the number of particles per release was defined as 10,000 in the *Numerical Parameters* Data Group and you have defined two releases each using 100% of the particles, then the total number of particles that will be used in the simulation will be $2 \times 10,000 = 20,000$ particles.

4.9.3 Radius of continuous release

D-WAQ PART can be used for studying the spread of substances in the mid-field region of interest. D-WAQ PART does not model the initial spreading and mixing (i.e., near-field) phenomena that occur as a discharge leaves a nozzle or outlet pipe and enters the ambient waters. The initial spreading and mixing occurs very quickly and quite close to the outlet point. In order to incorporate the effect of initial spreading in a D-WAQ PART simulation, it is possible to define a radius of the continuous release. The particles in the continuous release are then spread uniformly around the circumference of a circle with this radius, centred at the release point.

4.9.4 Release time and rate

The release rate per substance in m$^3$/s is defined in the time-series table in the *Release rates* section of the *Release tables for continuous releases* window as shown in Figure 4.14. The radio buttons alongside the table allows you to specify the *Interpolation method* that is to be used to define the time-series functions. The time-series function can be defined in one of the following two ways:

- **Linear interpolation method**
  The time-series of discharges is defined as a piecewise linear time-series. A series of discharges [m$^3$/s] are given at various time breakpoints (in time-date format). D-WAQ PART interpolates linearly between these time records. At least two time breakpoints must be defined.

- **Block interpolation method**
  The time-series of discharges is defined as a series of block functions. A series of discharges [m$^3$/s] are given at various time breakpoints (in time-date format). D-WAQ PART uses the discharge associated with a given time breakpoint as a constant value until a new time breakpoint and associated discharge is defined.

**Remark:**

- The *Generate table* button can be used to define a time-series with a constant user-defined time interval.

A *Scale factor* can be defined that is applied to all discharge values in the table. For example, if a time-series has been defined in litres per second [l/s], this can be converted to m$^3$/s by using a scale factor of 0.001.

You must define release rates for the entire simulation period. That is, the first time breakpoint must be equal to the simulation start time and the last time breakpoint must be equal to the simulation stop time.
### 4.9.5 Concentration of continuous release

The mass rate of release of a substance [kg/s] is given by the product of its discharge [m$^3$/s] and the concentration of the substance in the discharge [kg/m$^3$]. The concentration of each substance in the continuous release is defined in the *Concentrations* table in the *Release tables for continuous releases* window as shown in Figure 4.14.

In order to avoid a situation in which a given particle is used to represent several different substances at the same time, it is not recommended to define more than one non-zero concentration of substance per release location. If several substances are to be released at the same location, you should define separate release locations for each substance at this location.

#### Domain:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Lower limit</th>
<th>Upper limit</th>
<th>Default</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of continuous release</td>
<td>1 character</td>
<td>20 characters</td>
<td>(new)</td>
<td>-</td>
</tr>
<tr>
<td>x co-ordinate</td>
<td>-</td>
<td>-</td>
<td>0</td>
<td>m</td>
</tr>
<tr>
<td>y co-ordinate</td>
<td>-</td>
<td>-</td>
<td>0</td>
<td>m</td>
</tr>
<tr>
<td>Layer number (for 3D only)</td>
<td>1</td>
<td>no. of layers</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td>Percentage of depth below surface (for 2D only)</td>
<td>0 (surface)</td>
<td>100 (bottom)</td>
<td>0</td>
<td>%</td>
</tr>
<tr>
<td>Particles used</td>
<td>0</td>
<td>100</td>
<td>100</td>
<td>%</td>
</tr>
<tr>
<td>Radius of release</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>m</td>
</tr>
<tr>
<td>Interpolation method</td>
<td>block or linear</td>
<td>linear</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Scale factor</td>
<td>0</td>
<td>-</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td>Release rate: time breakpoints</td>
<td>start time</td>
<td>stop time</td>
<td>start time</td>
<td>date-time format</td>
</tr>
<tr>
<td>Release rate: discharge</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>m$^3$/s</td>
</tr>
<tr>
<td>Concentrations</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>kg/m$^3$</td>
</tr>
</tbody>
</table>

*Figure 4.15: Process parameters Data Group*
4.10 Process parameters

Selecting the Data Group Process Parameters opens a window as shown in Figure 4.15. If Oil has been selected in the Data Group Substances, the Process Parameters Data Group window will include an extra Oil Model check button as shown in Figure 4.16.

In this Process Parameters Data Group you can specify:

- decay rates
- sedimentation/erosion parameters
- physical parameters
- oil-specific parameters, if applicable.

4.10.1 Decay rates

Selecting the Sub-data Group Decay Rates opens the Decay Rates sub-window as shown in Figure 4.17.

The time-dependent decay rate for each of the substances defined in the Data Group Substances must be specified in the table. The time-series of decay rates is defined as a piece-wise linear time-series. A series of decay rates [1/day] are given at various time breakpoints (in time-date format). D-WAQ PART interpolates linearly between these time records. At least two time breakpoints must be defined covering the entire simulation period. That is, the first time breakpoint must be equal to the simulation start time and the last time breakpoint must be equal to the simulation stop time.

Remarks:

- The Table option in the menu bar can be used for the manipulation of table data.
The Generate table button can be used to define a time-series with a constant user-defined time interval.

For conservative tracers the decay rate is zero. If Oil has been selected in the Data Group Substances, the decay rate given here will be in addition to the model-specific decay processes (e.g. entrainment, evaporation, emulsification, etc.) that are defined in the Oil Model sub-window.

### Domain:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Lower limit</th>
<th>Upper limit</th>
<th>Default</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decay rates: time breakpoints</td>
<td>start time</td>
<td>stop time</td>
<td>start time</td>
<td>date-time format</td>
</tr>
<tr>
<td>Decay rates: decay rate</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>1/day</td>
</tr>
</tbody>
</table>

#### 4.10.2 Sedimentation/erosion

Selecting the Sub-data Group Sedimentation/erosion opens the sub-window with two check buttons as shown in Figure 4.18.
Sediment/erosion constants

Selecting Constants will open the sub-window shown in Figure 4.19.

You must specify whether to Include or Exclude sediment/erosion processes in the computation by selecting the appropriate radio button.

If sediment/erosion processes are to be included, additional parameters must be defined:

- Chézy coefficient \([m^{1/2}/s]\]
- Critical shear stress for sedimentation [Pa]
- Critical shear stress for erosion [Pa]

If the bed shear stress at any location is less than the critical shear stress for sedimentation, a particle that comes into contact with the bottom at that location, will remain attached to the bottom (sedimentation). For sedimentation, D-WAQ PART creates an extra model layer for sediment at the bed.

If the bed shear stress at any location is greater than the critical shear stress for sedimentation, a particle that comes into contact with the bottom at that location will be reflected back into the water column.

If the bed shear stress at any location is greater than the critical shear stress for erosion, all deposited particles at that location (i.e. particles located in the extra bed-sediment layer) will be returned to the water column instantaneously.

Domain:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Lower limit</th>
<th>Upper limit</th>
<th>Default</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sediment/erosion processes</td>
<td>include or exclude</td>
<td>exclude</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Chézy coefficient</td>
<td>0</td>
<td>-</td>
<td>55</td>
<td>(m^{1/2}/s)</td>
</tr>
<tr>
<td>Critical shear stress sedimentation</td>
<td>0</td>
<td>-</td>
<td>0.05</td>
<td>Pa</td>
</tr>
<tr>
<td>Critical shear stress erosion</td>
<td>0</td>
<td>-</td>
<td>0.4</td>
<td>Pa</td>
</tr>
</tbody>
</table>

Settling velocities

Selecting Settling velocities will open the sub-window shown in Figure 4.20.

You must define the coefficients \(A_0\) and \(A_1\), the period \(T\) and the phase \(\varphi\) as piecewise linear functions of time by selecting the appropriate check button in the Settling velocities sub-menu. In addition, you must also define the minimum and maximum allowable values for the calculated settling velocity by selecting the \(V_{min}\) and \(V_{max}\) check buttons respectively. \(V_{min}\) and \(V_{max}\) must also be defined as piecewise linear functions of time.

Values for all of the above parameters must be defined at various time breakpoints (in time-date format). D-WAQ PART interpolates linearly between these time records. At least two time breakpoints must be defined. You must define parameter values for the entire simulation period. That is, the first time breakpoint must be equal to the simulation start time and the last time breakpoint must be equal to the simulation stop time. The Table option in the menu bar...
Graphical User Interface

Figure 4.20: Settling velocities sub-window

can also be used to assist in the creation and manipulation of the table data.

Remarks:

♦ The time breakpoints must be the same for $A_0$, $A_1$, $T$, $\varphi$ and $V_{\text{min}}$ and $V_{\text{max}}$.
♦ If the calculated settling velocity lies outside the interval $[V_{\text{min}}, V_{\text{max}}]$ then the value is reset to $V_{\text{min}}$ if the calculated value is less than $V_{\text{min}}$. Similar for $V_{\text{max}}$. 

Deltares 43 of 134
### Domain:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Lower limit</th>
<th>Upper limit</th>
<th>Default</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exponent for concentration dependent settling velocity</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>-</td>
</tr>
<tr>
<td>grid refinement factor</td>
<td>0</td>
<td>-</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td>A0: time breakpoints</td>
<td>start time</td>
<td>stop time</td>
<td>start time</td>
<td>date-time format</td>
</tr>
<tr>
<td>A0: value</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>m/s</td>
</tr>
<tr>
<td>A1: time breakpoints</td>
<td>start time</td>
<td>stop time</td>
<td>start time</td>
<td>date-time format</td>
</tr>
<tr>
<td>A1: value</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>m/s</td>
</tr>
<tr>
<td>Period: time breakpoints</td>
<td>start time</td>
<td>stop time</td>
<td>start time</td>
<td>date-time format</td>
</tr>
<tr>
<td>Period: value</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>hours</td>
</tr>
<tr>
<td>Phase: time breakpoints</td>
<td>start time</td>
<td>stop time</td>
<td>start time</td>
<td>date-time format</td>
</tr>
<tr>
<td>Phase: value</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>hours</td>
</tr>
<tr>
<td>Vmin: time breakpoints</td>
<td>start time</td>
<td>stop time</td>
<td>start time</td>
<td>date-time format</td>
</tr>
<tr>
<td>Vmin: value</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>m/s</td>
</tr>
<tr>
<td>Vmax: time breakpoints</td>
<td>start time</td>
<td>stop time</td>
<td>start time</td>
<td>date-time format</td>
</tr>
<tr>
<td>Vmax: value</td>
<td>0</td>
<td>-</td>
<td>1000</td>
<td>m/s</td>
</tr>
</tbody>
</table>

### 4.10.3 Physical parameters

Selecting the Sub-data Group *Physical* will open the sub-window as shown in Figure 4.21.

This window is used to define the parameters related to the horizontal dispersion coefficient and the wind speed and direction.

*Horizontal dispersion coefficient*

The time-dependent horizontal dispersion coefficient is given as in Chapter 6.
Roughness length (2DH only)

If the hydrodynamic results from Delft3D-FLOW are 2-dimensional (2DH), D-WAQ PART will superimpose a logarithmic velocity profile in the vertical direction to emulate 3-dimensional hydrodynamic effects (see Chapter 6). This is the so-called 2.5 DH mode. The roughness length [m] defined here is a calibration parameter used to calculate the logarithmic velocity profile based on bottom shear stress.

Effect of wind

For 2DH hydrodynamics, the horizontal wind velocity given here is used to superimpose a vertical velocity profile over the depth-averaged velocity value from the hydrodynamic result file (see Chapter 6).

For 3D hydrodynamics, the horizontal wind velocity given here is only used if Oil has been selected in the Data Group Substances. In this case, the horizontal wind velocity is used to determine the additional wind-induced drift/deflection on surface floating oil (see Chapter 6). The horizontal wind velocity is defined by:

- wind drag coefficient, typically 1 %–3 %.
- wind speed at 10 m above the sea level
- wind direction in degrees relative to North

Remarks:

- Wind direction is given as the direction from which the wind is blowing. For example, wind from the North is 0.0 degrees.
- When the wind direction passes the North from one time point to another, the interpolation will fail. For instance: 350 degrees at time point $T_1$ and 10 degrees at time point $T_2$, will give 180 for the time point in the middle. To overcome this specify 370 degrees in stead of 10 degrees.

Both wind speed and direction must be specified as a piece-wise linear function of time. Wind effects can be applied on all tidal events and are in addition to the (overall) wind effects applied
in the hydrodynamic scenario.

Remarks:
- The *Table* option in the menu bar can be used for the manipulation of table data.
- The *Generate table* button can be used to define a time-series with a constant user-defined time interval.

**Density of water**
- density of water [kg/m$^3$]

**Domain:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Lower limit</th>
<th>Upper limit</th>
<th>Default</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal dispersion: coefficient a</td>
<td>0</td>
<td>-</td>
<td>1</td>
<td>m$^2$/s</td>
</tr>
<tr>
<td>Horizontal dispersion: coefficient b</td>
<td>0</td>
<td>-</td>
<td>0.01</td>
<td>-</td>
</tr>
<tr>
<td>Roughness length (2DH only)</td>
<td>0</td>
<td>-</td>
<td>0.02</td>
<td>m</td>
</tr>
<tr>
<td>Wind drag</td>
<td>0</td>
<td>-</td>
<td>1</td>
<td>%</td>
</tr>
<tr>
<td>Density of water</td>
<td>0</td>
<td>-</td>
<td>1024</td>
<td>kg/m$^3$</td>
</tr>
<tr>
<td>Wind: time breakpoints</td>
<td>start time</td>
<td>stop time</td>
<td>start time</td>
<td>date-time format</td>
</tr>
<tr>
<td>Wind: wind speed</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>m/s</td>
</tr>
<tr>
<td>Wind: wind direction</td>
<td>0</td>
<td>360</td>
<td>0</td>
<td>degrees</td>
</tr>
</tbody>
</table>

**4.10.4 Oil Model parameters**

Oil Model parameters must be supplied if *Oil* is selected in the *Substances Data Group*. Selecting the Sub-data Group *Oil Model* will open the sub-window as shown in Figure 4.22.

The oil spill model requires input to describe the following physical processes:
- evaporation
- beaching (sticking probability)
- emulsification
- dispersion (entrainment)
- decay
- initial spreading
- deflection due to Coriolis

Additional input fields for defining dispersion (entrainment), sticking probability and other oil parameters are available.
Evaporation

Evaporation in the oil model is described as a first-order decay process. The evaporation rate for each oil type must be defined by a decay coefficient, \( k_E \), where:

\[
\frac{dm}{dt} = -k_E t
\]  

(4.2)

where \( k_E \) is the evaporation rate in 1/day and \( t \) is the time in days.

Sticking probability (beaching)

In order to simulate the process of oil sticking to land or to the bed of the water column, a sticking probability must be specified. A particle may come into contact with land due to wind effects or horizontal dispersion and it may come into contact with the bed due to vertical dispersion or settling. The particle sticks to the land or bed if a randomly chosen number between 0 and 1 is smaller than the sticking probability given. For a sticking probability value of 1.0, all particles that come into contact with land or the bed will stick and become inactive particles (i.e., they will not be transported by water anymore). These particles are referred to as Sticking oil in the D-WAQ PART output.

Volatile fraction

This parameter, with a range of 0–1, specifies the fraction of the oil that can evaporate. The remainder will not evaporate.

Emulsification parameter

If this parameter is set to 0, then emulsification is switched off. When you decide to switch emulsification on, then it is recommended to use the default value of \( 2 \times 10^{-6} \).
**Maximum water content**

The maximum water content of the emulsion, ranging from 0–1, is required. It is an oil type dependent parameter.

**Fraction at which emulsification starts**

This parameter is dependent on the oil composition and may vary between 0–1. If emulsification occurs then a value of the order of 0.05–0.10 may be expected.

**Density of oil**

The density of oil is expressed in kg/m$^3$.

**Kinematic viscosity of oil**

The viscosity of oil is its resistance to shear or flow and is a measure of the oil adhesive/cohesive or frictional properties.

**Dispersion (entrainment)**

The entrainment of oil in water is referred to as dispersion. The dispersion rate may be defined using one of two dispersion options.

*User-defined dispersion*

The dispersion (entrainment) process is described by a first order process. The dispersion rate for each oil type must be defined by a decay coefficient, $k_D$ where:

$$\frac{dm}{dt} = -k_D t$$  \hspace{1cm} (4.3)

where $k_D$ is the dispersion rate in 1/day and $t$ is the time in days.

*Calculated dispersion*

The dispersion rate for each oil type is calculated directly by D-WAQ PART using the formulae given in Chapter 6. In this case, the density of oil should be supplied by you.

**Minimum oil layer thickness**

This parameter is used in the calculation of the dispersion (entrainment). Validation of the model has shown that the default value of 0.0005 m generally gives good dispersion rates. The parameter may be used to calibrate the dispersion process, if data is available. Otherwise it is recommended to use the default value.

**Deflection angle (Coriolis effect, 3D only)**

The advection of surface floating oil is subject to additional wind effects. The currents induced by wind and waves may act in addition to the currents described by the overall (e.g. tidal) hydrodynamics. The deflection angle is the angle between the wind direction and the actual direction of advection of the floating oil. The difference between the two directions arises because the waves move under the influence of Coriolis so that wave-induced transport is at an angle to the wind.

The deflection angle (nautical convention) can be defined in the data field as shown in Figure 4.22. The wind velocity and the drag coefficient are defined in the Physical sub-menu of the Data Group Process Parameters.
Remark:

- The deflection angle is not used for 2DH hydrodynamics. For 2DH hydrodynamics, a wind-induced parabolic velocity profile is superimposed over the entire depth. The deflection angle at the surface is not applicable here.

Domain:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Lower limit</th>
<th>Upper limit</th>
<th>Default</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evaporation rate</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>1/day</td>
</tr>
<tr>
<td>Sticking probability</td>
<td>0</td>
<td>1</td>
<td>0.5</td>
<td>-</td>
</tr>
<tr>
<td>Volatile fraction</td>
<td>0</td>
<td>1</td>
<td>0.94</td>
<td>-</td>
</tr>
<tr>
<td>Emulsification parameter</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>-</td>
</tr>
<tr>
<td>Maximum water content</td>
<td>0</td>
<td>1</td>
<td>1.0</td>
<td>-</td>
</tr>
<tr>
<td>Fraction at which emulsifica-</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>-</td>
</tr>
<tr>
<td>tion starts</td>
<td></td>
<td></td>
<td></td>
<td>1)</td>
</tr>
<tr>
<td>Density of oil</td>
<td>0</td>
<td>-</td>
<td>0.890</td>
<td>kg/m³</td>
</tr>
<tr>
<td>Kinematic viscosity</td>
<td></td>
<td></td>
<td>1500</td>
<td>cSt</td>
</tr>
<tr>
<td>Dispersion option</td>
<td>user-defined</td>
<td>calculated</td>
<td>calculated</td>
<td>-</td>
</tr>
<tr>
<td>User-defined dispersion rate</td>
<td>0</td>
<td>-</td>
<td>0</td>
<td>1/day</td>
</tr>
<tr>
<td>Minimum oil layer thickness</td>
<td>0</td>
<td>-</td>
<td>0.0005</td>
<td>m</td>
</tr>
<tr>
<td>Deflection angle</td>
<td>-360</td>
<td>360</td>
<td>0</td>
<td>degrees</td>
</tr>
</tbody>
</table>

1) These values are default values, when importing an input file generated from previous PART-GUI releases.

4.11 Observation points

Computational results can be monitored as a function of time by using observation points. Results for the observation points are written to a history file at user-specified time intervals. The time intervals for the output are defined in the Data Group Output Options. At the observation points, all computed quantities are stored as a function of time for post-processing and visualisation.

Selecting the Data Group Observation Points opens a window as shown in Figure 4.23.

Observation points are characterised by a name, and the co-ordinates of its location. Co-ordinates must be given in the Cartesian system.

To add an observation point:

- Click Add; an observation point named (new) is created.
Type the name of the observation point in the name box and confirm by pressing Enter on the keyboard. The name must be a non-blank name.

Use the Visualisation Area window or keyboard to specify the $x$ co-ordinate and the $y$ co-ordinate of the observation point.

To delete an observation point:

Select the required observation point from the list.

Click Delete.

Confirm that the observation point is to be deleted by selecting Yes in the confirmation window.

The observation point is then deleted from the list.

Observation points must be within the computational model area. In addition, an observation point should be located at some distance from a model boundary in order to provide reliable results. Half a grid interval is advised as a minimum distance from a boundary.

**Use of Zoom grid**

The values of concentration that are output at the observation points are the cell-averaged concentration values. Computational cells are generally quite large so that two observation points that are located close to each other within the same computational cell will thus give the same value. The resolution and accuracy of the output concentrations can be increased by using the so-called Zoom grid, which is defined in the Data Group Output Options. The Zoom grid allows you to define smaller cell sizes for the output. If an observation point is located within the Zoom grid, the output concentrations provided are the Zoom grid cell-averaged concentrations. If the observation point is located outside of the Zoom grid, the output concentrations provided are the computational cell-averaged concentrations.
4.12 Output options

The Data Group Output Options allows you to specify which results need to be stored for visualisation and at which time interval. Selecting the Data Group Output Options opens a window as shown in Figure 4.24.

Output from D-WAQ PART is stored in several different ways, namely:

- for selected observation points, at specified time intervals (history file)
- for the entire computational grid, at specified time intervals (map file)
- for a user-defined area, known as the Zoom Grid Output at specified time intervals

Output files

For each of the above output options, you must define the start time, the stop time and a time interval for the outputs. The output start time must be equal to or greater than the start time of the simulation. The output stop time must be greater than the output start time and the time interval for storing output must be an integer multiple of the time-step used in the simulation.

History file

The history file contains time-series of the computational results at each of the locations defined in the Data Group Observation Points.

4.12.1 Map file

The map file contains the computational results at every computational cell in the domain. The concentrations in the map file are the computational cell-averaged concentration values.
4.12.2 **Zoom grid**

The use of a zoom grid is compulsory.

The size of the computational cells is often so large that it is not possible to capture steep concentration gradients in the map file output. The resolution and accuracy of the output concentrations can be increased by using the so-called *Zoom grid*. The zoom grid allows you to define smaller cell sizes for a better presentation of the output results.

The zoom grid does not affect the computation of the processes. However, the following should be noted in relation to concentration-dependent settling.

If you choose to define a concentration-dependent settling velocity by selecting an exponent value $n \neq 0$, the local concentration of particles [kg/m$^3$] used in this formulation is taken from the zoom grid. The zoom grid should therefore be defined to cover the entire expected trajectory of the particles during the simulation.

The most important role of the zoom grid is to improve the spatial resolution of the output results.

**Definition of zoom grid**

The extent and grid cell size of the zoom grid is defined by selecting *Grid Definition* in the **Zoom grid** sub-window as shown in Figure 4.25. In order to define extent of the zoom grid, you must define the beginning and the end co-ordinates of the zoom grid. The size of the zoom grid cells is then determined by defining the number of cells to be used in the $x$ direction and the number of cells to be used in the $y$ direction.

The extent of the zoom grid can also be defined with the aid of the **Visualisation Area** window. In this case, you must first select the check box *Definition via Zoom Box (in Visualisation area)*; the **Visualisation Area** window will then open.

In the **Visualisation Area** window, you must select **Zoom → Zoom Box** as shown in Figure 4.26.

The extent of the zoom grid can then be defined graphically using the mouse to click and drag the outline of the desired grid extent. The zoom grid is presented in the visualisation window by solid red boundary lines. As soon as a new zoom grid is specified a new red box appears. It is only possible to define one zoom grid.

The $x$ and $y$ co-ordinates of the begin and end points of the zoom grid are transferred auto-

![Figure 4.25: Definition of Zoom grid](image-url)
matically to the input fields in the **Zoom grid** sub-window. You can then edit these values if desired.

### Zoom grid output

The concentration values [kg/m$^3$] in each zoom grid cell are calculated from the total mass of particles present in a cell divided by the volume of the cell. You must define the output times at which the concentrations in the zoom grid cells are to be output. Selecting **Zoom Grid Output in the Zoom grid** sub-window allows you to input the desired time intervals in the **time breakpoints** edit field as shown in Figure 4.27.

The time intervals must be given in time-date format. In addition, a **recovery factor** can be defined at each time interval. The **recovery factor** is a factor that can be used to relate the simulation results to field measurements. The results of the simulation are multiplied by this factor before being written to file. The results can thus be adjusted to match the measurements to take into account processes that may not have been included in the particle tracking simulation (e.g. additional losses due to evaporation or absorption to silt to the bottom).
4.12.3 Particle tracks

If the 3D tracks check box has been selected, D-WAQ PART will create an extra output file that contains information about the 3D location of every particle in the simulation at every time step. The size of this file will grow explosively for a large number of particles and for long simulation times. It is therefore suggested to use only a very limited number of particles when using this option (e.g. < 1000). The particle tracking output cannot be visualised using GPP. The data can be visualised using Delft3D-QUICKPLOT or alternatively using the Delft3D-MATLAB interface toolbox in MATLAB®. Please contact Deltares for further information.

4.12.4 Output file types

Each of the following file types can be visualised and plotted using the post-processing programs GPP or QUICKPLOT that are supplied with Delft3D.

Outputs for the history file are written to two files:

- DELWAQ | Binary history file <*.his>
- Delft3D | Mid field history file <his*.dat>

These files contain the same information but are written in different file formats.

Outputs for the map file are written to two files:

- DELWAQ | Binary map file <*.map>
- Delft3D | Mid field map file <map*.dat>

Remark:

- When plotting from the map files, first create the model grid (in GPP, Delft3D | Water quality grid file).

These files contain the same information but are written in different file formats.

Outputs for the Zoom grid output are written to two files:

- DELPAR | Binary plot grid file <*.plo>
- Delft3D | Mid field plot grid file <plo*.dat>

These files contain the same information but are written in different file formats.

The following output files cannot be visualised using GPP. Please contact Deltares for more information.

Output for the 3D(-Particle) tracks results are written to the file:

- Delft3D | tracking file <trk*.dat>

For the oil module a <type.csv> file is generated for each oil type with the name [type], as specified in the input file. It is an ASCII file containing the overall oil budget (floating, dispersed, evaporated and sticky) and average surface oil density, surface oil viscosity and water content. This file can be directly important into Excel.
4.13 Executing the scenario

4.13.1 Executing the water quality mid-field module D-WAQ PART

The particle tracking program D-WAQ PART can be executed within Delft3D-MENU. The input files for running D-WAQ PART are created by PART-GUI and contain all of the information required to execute D-WAQ PART. This means that no further input or manipulations are required from you after execution of the program is commenced.

**Error handling**

If an error occurs during the execution of a D-WAQ PART scenario, an error message is written to the ASCII report file <*.out>. The error message can be found in the report file by searching for the word ‘ERROR’ in the text. The report file can be viewed by selecting Reports on the Particle tracking main menu or by using any other ASCII text editor or viewer.

Some common errors include:

- using a quotation mark in the ‘description’ input field
- specifying a stop time that is less than the start time
- specifying incorrect stop times for <*.his> file and <*.map> file
- specifying a non-increasing series of plot times for results from the zoom grid
- specifying observation points or releases outside of the active grid (e.g. on land)
- specifying a bottom roughness coefficient of zero

4.13.2 Estimating run time

The run-time of D-WAQ PART depends mainly on the number of particles used and the kind of computer and processor used. For instantaneous releases, the CPU-time increases linearly with the number of particles. For continuous releases the CPU-time increases quadratically with the number of particles. For example, the tutorial example <fti_tracer.inp> supplied with D-WAQ PART, using a total of 100,000 particles requires approximately 2 minutes of CPU time on a Pentium IV, 1.6 GHz computer running Microsoft Windows. However, the same example run using a total of 1 million particles requires approximately 15 minutes on the same computer. Frequent outputs from the zoom grid and large numbers of observation points may slow down the performance.

4.13.3 File sizes

The size of the output files from D-WAQ PART simulations will depend on the length of the simulation, the number of observation points and the number of output time intervals defined for the zoom grid. The tutorial example <fti_tracer.inp> supplied with D-WAQ PART produces about 13 Mbytes of output files.
5 Tutorial

5.1 Introduction

This tutorial contains two cases which can be run with the D-WAQ PART module. The purpose of the tutorial is to:

- Give you experience with setting up a D-WAQ PART simulation, run the simulation and let you understand what D-WAQ PART can simulate.
- Check the installation of the D-WAQ PART-software.

This chapter gives both descriptive information about the steps to take to set up a D-WAQ PART simulation and GUI-operations to complete each step. The GUI-operations are displayed in the text boxes.

5.2 D-WAQ PART tutorial cases

5.2.1 Tutorial cases

The tutorial contains two applications of 3D simulations with the Delft3D-FLOW ‘Friesian Tidal Inlet’ schematisation. This schematisation contains 5 layers (aggregated from 10 hydrodynamic layers) and 330 segments per layer.

The applications are (see also Table 5.1):

- A simulation with two conservative tracers. One substance is released at the surface (layer 1) as an instantaneous (or ‘dye’) release. The other substance is released continuously in the bottom layer of the model (layer 5).
- A simulation for two oil fractions (Ekofisk and Heavy Fuel Oil) that are released instantaneously and as floating substances (a phase of floating oil on the water surface). The radius of the release is calculated with the oil-spill model. Dispersion of the oil is also calculated with the oil-spill model.

<table>
<thead>
<tr>
<th>Tutorial Case Tracer</th>
<th>Tutorial Case Oil</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>‘Friesian Tidal Inlet’</td>
</tr>
<tr>
<td>Hydrodynamic database</td>
<td>&lt;com-tut_fti_part.dat&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;com-tut_fti_part.def&gt;</td>
</tr>
<tr>
<td>Type of substance</td>
<td>Tracer(s)</td>
</tr>
<tr>
<td>Substances</td>
<td>‘Tracer’</td>
</tr>
<tr>
<td></td>
<td>‘Tracer con 52’</td>
</tr>
<tr>
<td>D-WAQ PART input file</td>
<td>&lt;fti_tracer.mdp&gt;</td>
</tr>
</tbody>
</table>

Table 5.1: Specifications of the tutorial cases
5.2.2 Starting D-WAQ PART

The D-WAQ PART model framework is started from the Delft3D-MENU as described in chapter 3 (Getting started).

<table>
<thead>
<tr>
<th>1. STARTING THE DELFT3D-MENU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new directory first</td>
</tr>
<tr>
<td>◇ Create a new directory somewhere on your hard-disk where you want to store the results of the Particle tracking simulation.</td>
</tr>
<tr>
<td>◇ Copy the &lt;com-tut_fi_part.dat&gt; and &lt;com-tut_fi_part.def&gt; files from your &lt;.../tutorial/part/friesian_tidal_inlet/all_flow_output&gt; directory to this freshly created directory.</td>
</tr>
<tr>
<td><strong>Start Delft3D</strong></td>
</tr>
<tr>
<td>◇ Start Delft3D-MENU.</td>
</tr>
<tr>
<td>◇ Click Part.</td>
</tr>
<tr>
<td>◇ Click the Select working directory button, the Select working directory window appears.</td>
</tr>
<tr>
<td>◇ Browse to your freshly created directory and enter this directory.</td>
</tr>
<tr>
<td>◇ Click OK to close the selection of your current working directory.</td>
</tr>
</tbody>
</table>

5.3 Coupling the hydrodynamic results

5.3.1 Coupling module

For both tutorials, the same hydrodynamic database is used. The database needs to be converted using the coupling program to make the necessary *.hyd>-file. The *.hyd>-file can then be used for both cases.

◇ Select the coupling program of D-WAQ PART by clicking Coupling and then Define input.

You are now accessing the GUI of the coupling module that will be described in the following section.

<table>
<thead>
<tr>
<th>2. STARTING THE COUPLING GUI</th>
</tr>
</thead>
<tbody>
<tr>
<td>In the Particle tracking-selection window, click Coupling and next Define input.</td>
</tr>
</tbody>
</table>

5.3.2 Definition of the input

The three data groups which are enabled are:

◇ Description
◇ Hydrodynamics
◇ Dispersion

The menu-items File and Help are also available.
**Description**

With *Description* you can add a file description in order to produce some meta-information about the coupling. Three lines of descriptive information are available, see Figure 5.1.

### 3. EDITING THE DESCRIPTION DATA GROUP

In the Delft3D-COUPLE window, click *Description*. Enter 3 lines (of max. 40 characters) of meta-information.

![Figure 5.1: Coupling GUI - Data Group Description](image)

**Hydrodynamics**

With the Data Group *Hydrodynamics*, the hydrodynamic database is selected. By selecting *Com-file*, you can browse to and select the `<com-tut_fti_part.dat>` file, which can be found in the `<.../tutorial/part/friesian_tidal_inlet/all_flow_output>` directory or in your current working directory (it was copied here, see section 5.2.2). By clicking *Open*, the `<com-tut_fti_part.dat>` file will be loaded into the GUI and information about this file will be displayed.

**Aggregation in time**

The timers in the file will automatically appear in the *Time information* frame. Time steps can be increased, for example in order to reduce the required disk space for storage. Here to, adapt the time step in the menu, but increase it only with an integer number (2 times, 3 times etc.).

In this tutorial we do not aggregate in time, so no adjustment of timers is needed.

**Horizontal aggregation**

The grid can be aggregated in the horizontal within the frame *Horizontal aggregation*. The three different options are:

- **No aggregation**: no spatial aggregation is used
- **Use aggregation file (only Delft3D-WAQ)**
- **Remove inactive cells**: all dry segments are deleted automatically.

Here we choose option: *Remove inactive cells*
**Vertical aggregation**

Layers can be aggregated in the vertical using the layer editor in the frame **Vertical aggregation.** This tutorial case contains 10 (hydrodynamic) layers. If no vertical aggregation is chosen, the number of water quality layers is equal to the number of hydrodynamic layers. To reduce storage space and decrease calculation time, the number of water quality layers can be reduced. To do so, select *Edit layers.* Figure 5.2a will appear.

![Layer editor](image)

**(a) Not aggregated**

**(b) Aggregated**

**Figure 5.2:** Vertical aggregation using the **Layer editor.** Left not aggregated and right aggregated layers.

On the left part of the **Layer editor** window, the number of water quality layers is shown. On the right-hand side, the corresponding number of hydrodynamic layers is shown. By changing the number in the input boxes (more than one hydrodynamic layer are combined to one water quality layer), the number of water quality layers decreases.

Create 5 water quality layers by (starting from the top) changing the number of hydrodynamic layers according to **Figure 5.2b.**

**Remarks:**
- The aggregation shown in **Figure 5.2b** defines the link between the hydrodynamic and water quality layers as follows:
  - water quality layer 1 = 2 hydrodynamic layers (1 and 2)
  - water quality layer 2 = 2 hydrodynamic layers (3 and 4)
  - water quality layer 3 = 2 hydrodynamic layers (5 and 6)
  - water quality layer 4 = 2 hydrodynamic layers (7 and 8)
  - water quality layer 5 = 2 hydrodynamic layers (9 and 10)

  This is referred to as a ‘2-2-2-2-2’ aggregation.
- The number of hydrodynamic layers remains intact (2+2+2+2+2=10).

The default situation when converting the hydrodynamic results is that there is NO vertical aggregation.
4. SPECIFYING AND AGGREGATING THE HYDRODYNAMIC DATABASE

In the Delft3D-COUPLE GUI, click Hydrodynamics.
Click Com-file, browse to the <.../tutorial/part/friesian_tidal_inlet/all_flow_input> directory or your current working directory and select the <com-tut_fti_part.dat> file.
Click Open to confirm (note that the details will be displayed in the Time information frame).
In the Horizontal aggregation frame, select Remove inactive cells (e.g. D-WAQ PART) from the Type of: drop-down box.
In the Vertical aggregation frame, click Edit layers.
From top to bottom, change in the edit fields the value into “2”.
Click OK to confirm.

As result your screen looks like Figure 5.3

![Figure 5.3: Coupling GUI - Data Group Hydrodynamics](image)

**Dispersion**

Only the water quality model D-Water Quality may use the vertical diffusion from the hydrodynamics. D-WAQ PART ignores them because the values point to exchanges (= transition from one cell to another). The random walk model used in D-WAQ PART is not dealing with these exchanges, so dispersion values are ignored. Default values (for D-Water Quality) are displayed. For the tutorial cases, no vertical diffusion coefficients are selected, see Figure 5.4.

5. EDITING DISPERSION

In the COUP-GUI, click Dispersion.
Do not check the Use minimum values check box.
5.3.3 Saving input and running the coupling module

By selecting File → Save (as) you are requested to save the file. Your current working directory is the correct location. Enter the filename <com-tut_fti_part.hyd>. The extension <hyd> will be given automatically. Selecting File → Exit to leave the COUP-GUI; you will be back in the Hydrodynamic coupling selection window. Click Start to start the coupling. A window will open in which the coupling of the hydrodynamic database is carried out. The Coupling program writes information about the coupling to this window. When the coupling is done, you can read this information (Figure 5.5) and close the window. Result files of the coupling will be available in your current working directory. An interesting file to inspect is <couplnef.out>.

![Coupling GUI](image)

*Figure 5.4: Coupling GUI - Data Group Dispersion*

![Coupling report output window](image)

*Figure 5.5: Coupling report output window*
6. SAVING INPUT AND RUNNING THE COUPLING

In the COUP-GUI, select **File** → **Save (as)** and save the file as `<com-tut_fti_part.hyd>` in your current working directory.

Exit the COUP-GUI by selecting **File** → **Exit**. Then select **Start** to start the coupling.

To inspect the results, click **Return**, then **Reports** and subsequently **Coupling** in the Delft3D-MENU, the file which will be displayed is `<couplnef.out>`.

5.4 Case 1: Tracer

Now the hydrodynamics have been coupled, the input for a PART simulation can be created. Step by step it will be explained how to set up the input for a PART simulation. Each data group will be explained. In this way the input file (`<fti_tracer.mdp>`) will be created.

Select the **Define input** button in the selection window for **Particle tracking** (see Figure 5.6).

![Figure 5.6: Selection window for Particle tracking](image)

This will start the PART-GUI (see Figure 5.7). With the GUI, you can input or edit data which are necessary for preparing a D-WAQ PART scenario (input file). The related data are divided in several data groups. From top to bottom, the following data groups are available: Description, Hydrodynamics, Substances, Time Frame, Initial Condition, Numerical Parameters, Instantaneous Releases, Continuous Releases, Process Parameters, Observation Points and Output Options.
5.4.1 Description

This data group allows you to add 3 lines of description (meta-information) about the D-WAQ PART scenario. Specify the 3 lines as in Figure 5.8.

7. DATA GROUP: description

In the PART-GUI, select Description.
Specify the lines of meta data like Figure 5.8.

When finished, you can click on the next data group, Hydrodynamics.

Figure 5.8: Data Group Description
5.4.2 Hydrodynamics

Available hydrodynamic results (e.g. <*.hyd>-files from the coupling module) can be selected in the Data Group Hydrodynamics. Press Select File to open the Select hydrodynamics file window. All the results found in the current working directory are listed; other results can be found by browsing to a different directory. Select the file <com-tut_fti_part.hyd>. The contents is listed in the Selected hydrodynamic results frame, Figure 5.9.

![Figure 5.9: Data Group Hydrodynamics showing the selected hydrodynamic results <com-tut_fti_part.hyd>](image)

8. DATA GROUP: hydrodynamics

In the PART-GUI, select Hydrodynamics. Press Select File and open the <com-tut_fti_part.hyd> file.

5.4.3 Substances

After selection of the Data Group Substances the window depicted in Figure 5.10 appears.

Select the Tracer radio button and use Add to add a second substances. In the list “(New)” appears. Change the name of the substances in:

- “Tracer con 52”
9. DATA GROUP: substances

In the PART-GUI, select Substances.
Select radio button Tracer in the Type of model frame.
Change the name in the Name of substance edit field into “Tracer”.
Click Add.
Change the name in the Name of substance edit field into “Tracer con 52”.
Click in the list box.

5.4.4 Time frame

Figure 5.11 shows the window corresponding to the Time Frame Data Group. The time frame of the hydrodynamic results is given. You can specify the following items:

- Stop time
- Time step

The start time for the water quality calculation cannot be changed. This is equal to the start time of the coupled hydrodynamics.

Set the timings according to Table 5.2.

Table 5.2: Timers for the Tracer tutorial case

<table>
<thead>
<tr>
<th></th>
<th>Tracer tutorial case</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start time</td>
<td>05/08/1990 12:30:00</td>
</tr>
<tr>
<td>Stop time</td>
<td>05/08/1990 20:30:00</td>
</tr>
<tr>
<td>Time step for calculation</td>
<td>15 minutes</td>
</tr>
</tbody>
</table>
10. DATA GROUP: time frame

In the PART-GUI, select Time Frame.
Specify the Stop time edit field: “05 08 1990 20 30 00”.
Specify the Time step edit field: “00 00 0000 00 15 00”.

5.4.5 Numerical parameters

Figure 5.12 corresponds to the Data Group Numerical Parameters. The following numerical parameters can be specified here:

- the number of particles
- vertical diffusion option
- vertical diffusion scaling factor

In this tutorial case, the number of particles is 100 000.
Two vertical diffusion options are available:

- **Depth averaged algebraic**: the vertical diffusion coefficient is not a function of \( z \), and its integral is approximated by an analytical function. However, it is a function of the \((x,y)\) co-ordinates depending on the local wind stress and bed stress.
- **Constant dispersion coefficient**: the vertical diffusion coefficient is a constant value for the whole model domain.

The other two options (Algebraic and Import from hydrodynamics) are expected in the near future, and will have the characteristics:

- **Algebraic**: coefficient is a function of \( z \) and its integral will be approximated.
- **Import from hydrodynamics**: coefficient is a function of \( z \).

The vertical diffusion scaling factor can be set by you. Its default value is 1, meaning the whole vertical diffusion coefficient is taken in the calculations. For the Tracer tutorial case, the vertical diffusion scaling factor is 0.05.

### 11. DATA GROUP: numerical parameters

In the PART-GUI, select **Numerical Parameters**.

Specify “100 000” in the **Number of particles** edit field.

Specify the “Depth averaged algebraic” radio button in the **Vertical dispersion** frame.

Set the **Scale factor** in the **Vertical dispersion** frame to: “0.05”.

### 5.4.6 Instantaneous releases

An instantaneous discharge of a substance is referred to as a ‘dye release’. In this data group you can prepare (see Figure 5.13): a list of dye releases with corresponding locations (co-ordinates), release radius, particles used (as % of the total number of particles), and a layer number where particles are released (which is 1 for 2D, and can be chosen for 3D calculations).

The location of an instantaneous release can be defined by using point-and-click in the Visualisation Area, or the \((x,y,z)\) co-ordinates of the location can be typed in on the main window of this data group. Note that for these locations the particle model does not work with grid-cell indices since these are not relevant here to. The release time and mass of substance released are given in a sub-window. Enter the values in Table 5.3, see Figure 5.13 and Figure 5.14.
### Table 5.3: Details of dye release 1

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>release name</td>
<td>dye release 01</td>
</tr>
<tr>
<td>location x [m]</td>
<td>193 049</td>
</tr>
<tr>
<td>location y [m]</td>
<td>609 122</td>
</tr>
<tr>
<td>layer</td>
<td>1</td>
</tr>
<tr>
<td>particles (% of total)</td>
<td>50</td>
</tr>
<tr>
<td>release radius [m]</td>
<td>0</td>
</tr>
<tr>
<td>release time</td>
<td>05/08/1990 12:30:00</td>
</tr>
<tr>
<td>substance released</td>
<td>Tracer</td>
</tr>
<tr>
<td>amount released [kg]</td>
<td>$1.0 \cdot 10^8$</td>
</tr>
</tbody>
</table>

**Remarks:**
- In a 3D model the release is discharged uniform over the selected layer. The $z$ co-ordinate has no meaning.
- In a 2D model the $z$ co-ordinate is a relative co-ordinate and refers to the relative depth below the water surface (0 % = surface, 100 % = bottom).
To use the point-and-click method, do not use Add, but select View → Visualisation Area from the menu bar. Set the Edit Mode to Add, see Figure 5.15. If not set yet, select Instantaneous releases in the Edit menu. To define a release at a specific location, move around with the cursor till you reach the specific location and then click with the left mouse. In the main window of the User Interface change the default name ‘(new)’ to ‘dye release 01’ and set the other characteristics according to Table 5.3.

12. DATA GROUP: instantaneous releases

In the PART-GUI, select Instantaneous Releases.

Click Add.

Specify “dye release 01” in the Instantaneous release edit field.

Specify “193049” in the X edit field.

Specify “609122” in the Y edit field.

Select layer “1” from the Layer drop-down box.

Specify “50” in the Particles used edit field.

Specify “0” in the Radius edit field.
12. DATA GROUP: instantaneous releases

Select dye release 1 (from the list) and click Release Tables.

In the Release tables for instantaneous releases window, specify (see Figure 5.14).

- “05/08/1990 12:30:00” in the Release time edit field (Time frame box)
- “1.000e+008” in the Tracer edit field (Substances frame).
- Click Close to return to the main window.

5.4.7 Continuous releases

In this data group (Figure 5.16 shows the corresponding window) you can prepare a list of continuous releases with corresponding locations, release radius, particles used (as % of the total particles), and a layer number (which is 1 for 2D, and can be chosen for 3D models).

The co-ordinates of the continuous release can be obtained with the Visualisation Area or can be typed in on the main window of this data group in (x, y)-co-ordinates. Note that for these locations the particle model does not work with grid-cell indices since these are not relevant for particle models. The release rates, stoichiometric coefficients per substance, and scale factor are given in a sub-window.

Table 5.5: Details of the continuous release

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>release name</td>
<td>cont. release 01</td>
</tr>
<tr>
<td>location x [m]</td>
<td>193567</td>
</tr>
<tr>
<td>location y [m]</td>
<td>605871</td>
</tr>
<tr>
<td>layer</td>
<td>5</td>
</tr>
<tr>
<td>particles (% of total)</td>
<td>50</td>
</tr>
<tr>
<td>release radius [m]</td>
<td>0</td>
</tr>
<tr>
<td>scale factor</td>
<td>1</td>
</tr>
<tr>
<td>release rate [m³/s]</td>
<td>1.0</td>
</tr>
<tr>
<td>substance</td>
<td>Tracer con 52</td>
</tr>
<tr>
<td>concentration [kg/m³]</td>
<td>1.0 · 10⁵</td>
</tr>
</tbody>
</table>
13. **DATA GROUP: continuous releases**

In the PART-GUI, select *Continuous releases*.
Click *Add*.
Specify “continuous release 1” in the *Continuous release* edit field.
Specify “193 567” in the *X* edit field.
Specify “605 871” in the *Y* edit field.
Select layer “5” from the *Layer* drop-down box.
Specify “50” in the *Particles used* edit field.
Specify “0” in the *Radius* edit field.
Select *continuous release 1* (from the list) and click *Release Tables*. 
13. DATA GROUP: continuous releases

In the Release tables for continuous releases window, specify (see Figure 5.17):

- Specify in the first time breakpoint row: “05 08 1990 12 30 00” in the first column and “1.000” in the second column [m³/s].
- Specify in the second time breakpoint row: “05 08 1990 20 30 00” in the first column and “1.000” in the second column [m³/s].
- Select interpolation method “linear” (radio button).
- Specify Scale factor: “1.0”.
- “1.000e+005” in the Tracer con 52 edit field (Concentration frame).
- Click Close to return to the main window.

5.4.8 Process parameters

In the Data Group Process Parameters you can define:

- first order decay rates [d⁻¹] for mass decay of substances
- parameters for sedimentation and erosion of particles
- physical parameters (for wind, bed stress and diffusion)
- oil specific parameters (oil model only)

Decay rates

Decay rates are given in a table, per substance and per time breakpoint in units per day. Click Decay Rates to display the table (see Figure 5.18).

![Figure 5.18: Data Group Process Parameters with sub-data group Decay rates](image-url)
**Sedimentation/Erosion**

When clicking *Sedimentation/Erosion*, two additional sub-data groups appear, namely:

- Constants
- Settling velocities

First, you must specify if sedimentation and erosion from the bottom is included or excluded (see Figure 5.19). When erosion is included, 3 parameters must be specified for sedimentation and erosion according to Partheniades (1965) and Krone (1962). In the tutorial examples this is not further discussed, since erosion is excluded.

![Figure 5.19: Sub-data group Sedimentation/erosion – Constants](image)

Settling velocities are given with 6 parameters (two amplitudes, \(a_0\) and \(a_1\)); period \(\omega\), phase \(\phi\), minimum \(v_{\text{min}}\) and maximum \(v_{\text{max}}\) settling velocities) and are also given in tables. Each of the 6 parameters has its own table, per substance and time breakpoint.
For this tutorial case, these parameters must be specified as given in Table 5.7.

**Table 5.7: Process parameters**

<table>
<thead>
<tr>
<th>Description</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decay</td>
<td></td>
<td>No decay</td>
</tr>
<tr>
<td>Settling Velocities</td>
<td>A0 [m/s]</td>
<td>$1.0 \cdot 10^{-4}$ (Tacer)</td>
</tr>
<tr>
<td></td>
<td>A1 [m/s]</td>
<td>0.0 (Tracer con 52)</td>
</tr>
<tr>
<td></td>
<td>period [h]</td>
<td>0.0</td>
</tr>
<tr>
<td></td>
<td>phase [h]</td>
<td>0.0</td>
</tr>
<tr>
<td></td>
<td>$V_{min}$ [m/s]</td>
<td>-10</td>
</tr>
<tr>
<td></td>
<td>$V_{max}$ [m/s]</td>
<td>100</td>
</tr>
<tr>
<td>Physical Parameters</td>
<td>coefficient a</td>
<td>0.07</td>
</tr>
<tr>
<td></td>
<td>coefficient b</td>
<td>0.7</td>
</tr>
<tr>
<td></td>
<td>roughness [m]</td>
<td>0.002</td>
</tr>
<tr>
<td></td>
<td>wind drag [%]</td>
<td>3.0</td>
</tr>
<tr>
<td></td>
<td>density of water [kg/m$^3$]</td>
<td>1024.0</td>
</tr>
<tr>
<td></td>
<td>wind speed [m/s]</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>wind direction [degrees]</td>
<td>270</td>
</tr>
</tbody>
</table>
**Physical**

So-called physical process parameters contain constants as well as time dependent parameters of wind and horizontal dispersion. See Figure 5.21 and Table 5.7.

![Figure 5.21: Physical Process parameters](image)

### 14. DATA GROUP: process parameters

In the PART-GUI, select *Process Parameters*.

Click *Decay rates*.

Specify the table according to Figure 5.18.

Click *Sedimentation/erosion*.

Click *Constants*.

Select the *Exclude sedimentation and erosion processes* radio button.

Click *Settling Velocities*.

Specify each item according Table 5.7.

Click *Physical*.

Specify each item according Table 5.7.

#### 5.4.9 Observation points

To have a time history of results at a single point, observation points can be selected (the corresponding data group window is presented in Figure 5.22). A list of observation points, i.e. their names and their co-ordinates can be given here.

In this tutorial case, a single observation point has been chosen (‘waste point’) at location:

\[ x = 193\,567; \ y = 605\,871 \]

Observation points can also be added with the *Visualisation Area*. 

---

76 of 134  Deltareas
15. DATA GROUP: observation points

In the PART-GUI, select Observation points. 
Click Add. 
Change the name of the observation point into: “waste point”. 
Specify “193567” in the X edit field. 
Specify “605871” in the Y edit field.

5.4.10 Output options

This data group (see Figure 5.23) contains the time frames for standard output results (history file and map file) and the following additional output options:

- A zoom grid, together with its rectilinear grid dimensions.
- The Zoom Grid Output.

The Zoom Grid Output must be set to specific moments in time using the table displaying the time breakpoints.

(Zoom grid) Grid definition

The zoom grid should be defined in the following way (4 edit fields):

- X: from 185 000 (lower) to 210 000 (upper)
- Y: from 600 000 (lower) to 625 000 (upper)
- Number of cells in both x- and y-direction: 150.
**Figure 5.23:** Data Group Output Options, with also showing options for Grid Definition of the Zoom grid

16. **DATA GROUP: output options**

In the PART-GUI, select *Output Options.*

Change (if necessary) the content of the *Time frame* according Figure 5.23.

Click *Grid Definition* in the *Zoom grid* frame.

Specify “185000” in the *X lower* edit field.

Specify “210000” in the *X upper* edit field.

Specify “600000” in the *Y lower* edit field.

Specify “625000” in the *Y upper* edit field.

Specify “150” in the *Number of cells in X-direction* edit field.

Specify “150” in the *Number of cells in Y-direction* edit field.

Click *Output Definition.*

Specify (using menu-item *Table* → *Insert row*) the number of breakpoints table according Table 5.8.
Table 5.8: Time breakpoints definition

<table>
<thead>
<tr>
<th>time breakpoints</th>
<th>recovery factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>dd mm yyyy hh mm ss</td>
<td>1.000</td>
</tr>
<tr>
<td>05 08 1990 12 30 00</td>
<td>1.000</td>
</tr>
<tr>
<td>05 08 1990 12 45 00</td>
<td>1.000</td>
</tr>
<tr>
<td>05 08 1990 13 00 00</td>
<td>1.000</td>
</tr>
<tr>
<td>05 08 1990 13 15 00</td>
<td>1.000</td>
</tr>
<tr>
<td>05 08 1990 13 30 00</td>
<td>1.000</td>
</tr>
<tr>
<td>05 08 1990 20 15 00</td>
<td>1.000</td>
</tr>
<tr>
<td>05 08 1990 20 30 00</td>
<td>1.000</td>
</tr>
</tbody>
</table>

(Zoom grid) Output definition

The tutorial case has 8 time breakpoints for which output is written to this zoom grid. These time breakpoints should be defined (see Figure 5.24). Select a row in the time breakpoints table and select the menu-item Table → Insert row. Now a row is added to the time breakpoints table. Change the content of the newly added row according to Table 5.8, for this tutorial we use the button Generate table.

Figure 5.24: Zoom Grid Output

5.4.11 Saving the input

By selecting the menu-item File → Save as... you can specify a file name for your PART simulation. Suggestion is to name it <fti_tracer.mdp>. It will be automatically stored in your current working directory. Select menu-item File → Exit, ignore the message when you saved your work already. Now your input file is ready and the simulation can take place (see section 5.6).
5.5 Case 2: Oil

After the hydrodynamics have been coupled (see section 5.3), the input for a PART-simulation can be created. The hydrodynamic database is the same as in the Tracer tutorial case. Step by step it will be explained how to set-up the input for a PART-simulation (oil module). Each data group will be explained. In this way the input file (\texttt{fti\_oil.mdp}) will be created.

Select \textit{Define input} in the selection window for \textbf{Particle tracking}, see Figure 5.25.

![Figure 5.25: Selection window for Particle tracking](image)

This will start the PART-GUI (see Figure 5.26). With the GUI you can input or edit data which are necessary for preparing a D-WAQ PART scenario (input file). The related data are divided in several data groups. From top to bottom, the following data groups are available: Description, Hydrodynamics, Substances, Time Frame, Initial Conditions, Numerical Parameters, Instantaneous Releases, Continuous Releases, Process Parameters, Observation Points and Output Options.
5.5.1 Description

This data group allows you to add 3 lines of description (meta-information) in a D-WAQ PART input file. Specify the 3 lines as in Figure 5.8.

1. DATA GROUP: description

In the PART-GUI, select Description. Specify the lines of metadata like Figure 5.27.

When finished, you can click on the next data group, Hydrodynamics.

![Figure 5.26: Main window of the PART-GUI](image)

![Figure 5.27: Data Group Description](image)
5.5.2 Hydrodynamics

Available hydrodynamic results (e.g. `<*.hyd>`-files from the coupling module) can be selected in the Data Group Hydrodynamics. All the results found in the current working directory are listed, whereas other results can be found by browsing to a different directory. The file `<com-tut_fti_part.hyd>` is already listed in the Select hydrodynamics file window.

![Figure 5.28: Data Group Hydrodynamics showing the selected hydrodynamic results `<com-tut_fti_part.hyd>`](image)

2. DATA GROUP: hydrodynamics

In the PART-GUI, select Hydrodynamics

The `<com-tut_fti_part.hyd>` file is listed in the Select hydrodynamics file window.

5.5.3 Substances

After selection of the Substances Data Group the window depicted in Figure 5.29 appears.

Select the Oil radio button, the oil type “Ekofisk” is immediately available, use the Add button to add a second substance. In the list (new) appears. Change the name of the substance in:

- "Heavy Fuel Oil"
- Click in the list box

Note that oil substances are always given in three fractions, namely:

- Floating oil: oil that is floating as a thin layer on top of the water column,
- Dispersed oil: oil that is in the water column (‘dissolved’ oil droplets),
- Sticking oil: oil that (may) stick to land or to the bed, this fraction is no longer transported by water.
3. DATA GROUP: substances

In the PART-GUI, select Substances.
Select radio button Oil in the Type of model frame.
Change name in the Name of substance edit field into “Ekofisk”.
Click Add.
Change name in the Name of substance edit field into “Heavy Fuel Oil”.
Click in the list box.

5.5.4 Time frame

Figure 5.30 shows the window corresponding to the Time Frame Data Group. The time frame of the hydrodynamic results is given. You can specify the following items:

- Stop time
- Time step

The start time for the water quality calculation cannot be changed. This is equal to the start time of hydrodynamic calculation (after coupling).
### Table 5.9: Timers for the Oil tutorial case

<table>
<thead>
<tr>
<th></th>
<th>Oil tutorial case</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start time</td>
<td>05/08/1990 12:30:00</td>
</tr>
<tr>
<td>Stop time</td>
<td>05/08/1990 20:30:00</td>
</tr>
<tr>
<td>Time step for calculation</td>
<td>15 minutes</td>
</tr>
</tbody>
</table>

#### 4. DATA GROUP: time frame

In the PART-GUI, select Time Frame. Specify the Stop time edit field: “05 08 1990 20 30 00”. Specify the Time step edit field: “00 00 0000 00 15 00”.

### 5.5.5 Initial condition

In this Data Group you select whether or not you want to specify the extent of initial oil patches, by selecting an initial patch file. The file specifies the extent, the amount of oil for each patch and the number of particles to represent each patch of oil. The number of particles specified here are in addition to those specified in the Numerical Parameters Data Group. The format of the initial condition file is specified in section A.6.
5. DATA GROUP: *Initial Condition*

In the PART-GUI, select *Initial Conditions*.
Select radio button *Initial oil patches*.
Press the *Select file* button.
Select file `<ekofisk_hfo.ini>`.
Click *Open*.
5.5.6 Numerical parameters

Figure 5.33 corresponds to the Numerical Parameters Data Group. The following numerical parameters can be set here:

- number of particles
- vertical dispersion option
- vertical dispersion scaling factor

![Figure 5.33: Data Group Numerical Parameters]

In this tutorial case, the number of particles is 200,000.

Two vertical dispersion options are available:

- **Depth averaged algebraic**: the vertical dispersion coefficient is not a function of \( z \), and its integral is approximated by an analytical function. However, it is a function of the \((x, y)\) co-ordinates depending on the local wind stress and bed stress.
- **Constant dispersion coefficient**: the vertical dispersion coefficient is a constant for the whole model domain.

The other two options (**Algebraic** and **Import from hydrodynamics**) are expected in the future, and will have the characteristics:

- **Algebraic**: coefficient is a function of \( z \) and its integral will be approximated.
- **Import from hydrodynamics**: coefficient is a function of \( z \).

The vertical dispersion scaling factor can be set by you. Its default value is 1, meaning the whole vertical dispersion coefficient is taken in the calculations. For the Oil tutorial case, the vertical dispersion scaling factor is 0.1.

### 6. DATA GROUP: numerical parameters

In the PART-GUI, select **Numerical Parameters**.
Specify “200000” in the **Number of particles** edit field.
Specify the “Depth Averaged algebraic” radio button in the **Vertical dispersion** frame.
Set the **Scale factor** in the **Vertical dispersion** frame to: “0.1”.
### Table 5.10: Details of oil releases

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>release name</td>
<td></td>
</tr>
<tr>
<td>oil patch 1</td>
<td>oil patch 2</td>
</tr>
<tr>
<td>location x [m]</td>
<td>193049</td>
</tr>
<tr>
<td>location y [m]</td>
<td>609122</td>
</tr>
<tr>
<td>particles (% of total)</td>
<td>50</td>
</tr>
<tr>
<td>release radius [m]</td>
<td>calculated</td>
</tr>
<tr>
<td>release time</td>
<td>05/08/1990 12:30:00</td>
</tr>
<tr>
<td>substance released</td>
<td>Ekofisk</td>
</tr>
<tr>
<td>amount released</td>
<td>$1.0 \cdot 10^6$ [kg]</td>
</tr>
</tbody>
</table>

#### 5.5.7 Instantaneous releases

In this data group you can prepare (see Figure 5.34): a list of instantaneous releases with corresponding locations (co-ordinates), release radius, particles used (as % of the total number of particles), and a layer number where particles are released (which is 1 for 2D, and can be chosen for 3D calculations).

The co-ordinates of the instantaneous release can be obtained with the Visualisation Area by point-and-click. You can also enter in the main window of this data group the $(x, y, z)$ co-ordinates. Note that for these locations, as with all location references in PART, the particle model does not work with grid-cell indices since these are not relevant here to. The release time and mass of substance released are given in a sub-window:

**Remark:**

- The volume can be calculated by dividing the total discharge ($1.0 \cdot 10^6$ kg) by the density ($850$ kg/m$^3$ for oil patch 1 and $990$ kg/m$^3$ for oil patch 2, see section 5.5.9).
Remark:

- Oil can only be released at the water surface (Layer 1, top of that layer). The \( z \)-value edit field and Layer drop-down box are disabled.

---

**Figure 5.35: Release tables for instantaneous releases** window for oil patch 1

<table>
<thead>
<tr>
<th>Substances</th>
<th>Ekolink [kg]</th>
<th>Heavy Fuel Oil [kg]</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1.000e+006</td>
<td>0.000</td>
</tr>
</tbody>
</table>

**Figure 5.36: Release tables for instantaneous releases** window for oil patch 2

---

7. DATA GROUP: instantaneous releases

In the PART-GUI, select Instantaneous Releases.

Click Add.

Specify “oil patch 1” in the Instantaneous release edit field.

Specify “193049” in the \( X \) edit field.

Specify “609122” in the \( Y \) edit field.

Specify “50” in the Particles used edit field.

Select radio button Calculated radius.

Click Add (again).

Specify “oil patch 2” in the Instantaneous release edit field.

Specify “193567” in the \( X \) edit field.

Specify “605871” in the \( Y \) edit field.

Specify “50” in the Particles used edit field.

Select radio button Calculated radius.
7. **DATA GROUP: instantaneous releases**

Select oil patch 1 (from the list) and click Release Tables.

In the **Release tables for instantaneous releases** window, specify (see Figure 5.35):

- “05/08/1990 12:30:00” in the **Release time** edit field (**Time frame** box).
- “1.000e+006” in the **Ekofisk** edit field (**Substances** box).
- Click **Close** to return to the main window.

Select oil patch 2 (from the list) and click Release Tables.

In the **Release tables for instantaneous releases** window, specify (see Figure 5.36):

- “05/08/1990 12:30:00” in the **Release time** edit field (**Time frame** box).
- “1.000e+006” in the **Heavy Fuel Oil** edit field (**Substances** box).
- Click **Close** to return to the main window.

### 5.5.8 Continuous releases

There are no continuous releases in this tutorial case.

### 5.5.9 Process parameters

In the Data Group **Process Parameters** (see Figure 5.37) you can define:

- first order decay rates \([d^{-1}]\) for mass decay of substances
- parameters for sedimentation and erosion of particles
- physical parameters (for wind, bed stress and diffusion)
- oil specific parameters (oil model only)

#### Decay rates

Decay rates are given in a table, per substance and per time breakpoint in units per day. For oil you can specify decay rates per fraction (floating, dispersed, sticked). Click **Decay Rates** to inspect the table. All values should be zero (use the horizontal scroll bar).
When clicking Sedimentation/Erosion, two additional sub-data groups appear, namely:

- Constants
- Settling Velocities

First, you must specify if sedimentation or erosion from the bottom is included or excluded (see Figure 5.38). When erosion is included, parameters must be specified for sedimentation and erosion according to Partheniades (1965) and Krone (1962). In the tutorial examples this is not further discussed, since erosion is excluded.

Settling velocities are given with 6 parameters (two amplitudes, \(a_0\) and \(a_1\); period \(\omega\), phase \(\varphi\), minimum \(v_{\text{min}}\) and maximum \(v_{\text{max}}\) settling velocities), and are also given in tables. Each of the 6 parameters has its own table, per substance and time breakpoint.
### Table 5.12: Process parameters for Sedimentation and Erosion

<table>
<thead>
<tr>
<th>Description</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settling Velocities for <em>Ekofisk dispersed</em> and <em>HFO dispersed</em></td>
<td>$A_0$ [m/s]</td>
<td>$-1.0 \cdot 10^{-4}$</td>
</tr>
<tr>
<td></td>
<td>$A_1$ [m/s]</td>
<td>0.0</td>
</tr>
<tr>
<td></td>
<td>period [h]</td>
<td>0.0</td>
</tr>
<tr>
<td></td>
<td>phase [h]</td>
<td>0.0</td>
</tr>
<tr>
<td></td>
<td>$V_{min}$ [m/s]</td>
<td>-10</td>
</tr>
<tr>
<td></td>
<td>$V_{max}$ [m/s]</td>
<td>100</td>
</tr>
</tbody>
</table>

**Remark:**

◊ The time breakpoints most be the same for all parameters.

---

For this tutorial case, these parameters must be specified as given in Table 5.14. The negative settling velocity for dispersed oil gives the oil buoyancy.
Table 5.13: Physical process parameters

<table>
<thead>
<tr>
<th>Description</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical Parameters</td>
<td>coefficient a</td>
<td>0.07</td>
</tr>
<tr>
<td></td>
<td>coefficient b</td>
<td>0.7</td>
</tr>
<tr>
<td></td>
<td>roughness [m]</td>
<td>0.002</td>
</tr>
<tr>
<td></td>
<td>wind drag (%)</td>
<td>3.0</td>
</tr>
<tr>
<td></td>
<td>density of water [kg/m³]</td>
<td>1024</td>
</tr>
<tr>
<td></td>
<td>wind speed [m/s]</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>wind direction [degrees]</td>
<td>270</td>
</tr>
</tbody>
</table>

Physical

So-called physical process parameters contain constants as well as time dependent parameters of wind and horizontal diffusion, see Figure 5.40. These parameters must be specified as given in Table 5.13.

Figure 5.40: Physical Process parameters
### Table 5.14: Process parameters for oil

<table>
<thead>
<tr>
<th>Description</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oil Model</td>
<td>Evaporation per day</td>
<td>0.4 0.05</td>
</tr>
<tr>
<td></td>
<td>Stickyness probability</td>
<td>0.0 0.5</td>
</tr>
<tr>
<td></td>
<td>Volatile fraction</td>
<td>1 0.94</td>
</tr>
<tr>
<td></td>
<td>Emulsification parameter $C_1$</td>
<td>0 $2 \cdot 10^{-6}$</td>
</tr>
<tr>
<td></td>
<td>Maximum water content</td>
<td>1 0.7</td>
</tr>
<tr>
<td></td>
<td>Fraction at which emulsification starts</td>
<td>1 0.05</td>
</tr>
<tr>
<td></td>
<td>Density</td>
<td>850 990</td>
</tr>
<tr>
<td></td>
<td>Kinematic viscosity</td>
<td>50 1500</td>
</tr>
<tr>
<td></td>
<td>Dispersion (entrainment)</td>
<td>calculated</td>
</tr>
<tr>
<td></td>
<td>Minimum thickness</td>
<td>0.00005 0.00005</td>
</tr>
<tr>
<td></td>
<td>Deflection angle</td>
<td>0 0</td>
</tr>
</tbody>
</table>

**Oil Model**

In this part, specific oil parameters are specified concerning dispersion, evaporation, emulsification, etc., see Figure 5.41. Fill in the values as indicated in Table 5.14.

![Oil Model specific parameters](image-url)

**Figure 5.41: Oil Model specific parameters**
8. DATA GROUP: process parameters

In the PART-GUI, select Process Parameters.
Click Sedimentation/erosion.
Click Constants.
Select the Exclude sedimentation and erosion processes radio button.
Click Settling Velocities.
Specify each item according to Table 5.12.
Click Physical.
Specify each item according to Table 5.13/Figure 5.40.
Click Oil Model.
Specify each item according to Table 5.14/Figure 5.41.

5.5.10 Observation points

To have a time history of results at a single point, observation points can be selected (the corresponding data group window is presented in Figure 5.22. A list of observation points, i.e. their names and their co-ordinates can be given here.

![Data Group Observation Points](image)

*Figure 5.42: Data Group Observation Points*

In this tutorial case, a single observation point has been chosen (‘waste point oil’) at location:

\[ x = 193,567; \ y = 605,871 \]

Observation points can also be added with the Visualisation Area.
9. DATA GROUP: observation points

In the PART-GUI, select Observation Points.
Click Add.
Change the name of the observation point into: “waste point oil”.
Specify “193567” in the X edit field.
Specify “605871” in the Y edit field.

5.5.11 Output options

This data group (see Figure 5.43) contains the time frames for standard output results (history file and map file) and additional output mapped on a rectangular zoom grid.

The output to the zoom grid must be set to specific moments in time using the table displaying the time breakpoints.

![Data Group Output Options](image)

*Figure 5.43: Data Group Output Options, also showing options for Definition of Zoom grid*

**(Zoom grid) Grid definition**

The zoom grid should be defined in the following way (4 edit fields):

- **X**: from 185000 (lower) to 210000 (upper)
- **Y**: from 600000 (lower) to 625000 (upper)
- Number of cells in x- and y-direction is: 150.
(Zoom grid) Output definition

The tutorial case has 8 time breakpoints for which output is written to this zoom grid. These time breakpoints should be defined (see Figure 5.44). Select a row in the time breakpoints table and select the menu-item Table → Insert row. Now a row is added to the time breakpoints table. Change the content of the newly added row according to Table 5.15, for this tutorial we use the button Generate table.

Figure 5.44: Zoom Grid Output

Table 5.15: Time breakpoints definition

<table>
<thead>
<tr>
<th>time breakpoints</th>
<th>recovery factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>dd mm yyyy hh mm ss</td>
<td>1.000</td>
</tr>
<tr>
<td>05 08 1990 12 30 00</td>
<td>1.000</td>
</tr>
<tr>
<td>05 08 1990 12 45 00</td>
<td>1.000</td>
</tr>
<tr>
<td>05 08 1990 13 00 00</td>
<td>1.000</td>
</tr>
<tr>
<td>05 08 1990 20 15 00</td>
<td>1.000</td>
</tr>
<tr>
<td>05 08 1990 20 30 00</td>
<td>1.000</td>
</tr>
</tbody>
</table>

5.5.12 Saving the input

By selecting the menu-item File → Save as... you can specify a file name for your PART simulation. Suggestion is to name it <fti_oil.mdp>. It will be automatically stored in your current working directory. Select menu-item File → Exit and ignore the message when you already saved your work. Now your input file is ready and the simulation can take place (see section 5.6).
5.6 Executing a scenario

Once you leave the PART-GUI, you will return to the main menu. The calculation can be started by selecting Start from the main menu screen (Figure 5.6).

The model will always run with the latest input file that has been opened and saved.

While the model is running, you will see on the screen the hydrodynamic flow and volume records updated, the actual time, and the number of active particles in the calculation. When the calculation is finished, you will again see the main menu of D-WAQ PART.

When the model stops before the end of simulation without an error message, then check the report file on the word ‘ERROR’. Errors in the syntax of the input file must appear directly on the screen in front of you. There should be no errors and no warnings for the two tutorial cases.

5.7 Viewing the report

A report of each model calculation is made, and this can be viewed by selecting Reports from the main menu screen. By clicking Monitoring and Select file, you can browse to the \(<*.out>\) file (\(* = name of scenario\)). You can scroll through the file to read any error or warning messages for the D-WAQ PART calculation.

The possible error and warning messages are supposed to be instructive and clear enough for you to make the necessary corrections. Look for the words ‘ERROR’ and ‘WARNING’ (capital letters). There should be no errors and no warnings for the two tutorial cases.

5.8 Viewing the results

To view output of a PART simulation, the Delft3D-QUICKPLOT or GPP (General Post Processing) program must be used. By selecting QUICKPLOT or GPP in the selection window for Particle tracking (Figure 5.6), QUICKPLOT or GPP starts.

GPP:
For GPP to open the so-called session file (\(<*.ssn>\)), the datasets and plots of the tutorial examples will be opened. The session files to open are \(<tutorial_part_fti_tracer.ssn>\) or \(<tutorial_part_fti_oil.ssn>\). Both can be found in the \(<\ldots\tutorial\part\friesian_tidal_inlet>\) directory. Use the menu-item Session → Open... (click “No” if you are asked to save changes) to browse to the required file, click Open to confirm.

The plots can be found when you click Plots. Select a plot from the list and click View → Edit to open it.

Remarks:
- The ‘tracer’ plot can only be viewed if you have finished the tutorial Tracer case.
- The ‘oil’ plot can only be viewed if you have finished the tutorial Oil case.

Deltares
Figure 5.45: Tracer Case: Instantaneous release: situation at 18:00 hrs (upper) and 19:30 hrs (lower) in the surface layer.
Figure 5.46: Tracer Case: Continuous release: situation at 20:30 hrs in layer 3: MAP-file (upper) and PLO-file (lower)
Figure 5.47: Oil Case: Situation at 19:30 hrs in the surface layer: Ekofisk dispersed (upper) and Floating HFO (lower)
Figure 5.48: Oil Case: Situation at 17:00 hrs (upper) and 19:30 hrs (lower), PLO-file for Floating HFO in the surface layer
6  Conceptual model

6.1  Introduction

D-WAQ PART is a 3-dimensional particle tracking model that is particularly useful for mid-field water quality modelling. It calculates a dynamic concentration distribution by following the tracks of thousands of particles with time. The model provides a detailed description of concentration distributions, resulting from instantaneous or continuous releases of salt, oil, temperature or other conservative or simple decaying substances. This chapter gives you a brief introduction to the computer model and its applications (see also WL | Delft Hydraulics (1993); Van den Boogaard et al. (1993)).

6.1.1  Operational functionality

D-WAQ PART can operate in the following modes:

- Standard mode: 3D or 2DH mode: D-WAQ PART coupled to 3D or 2DH Delft3D-FLOW (one layer model or multi-layer model, sigma-layers only, Z-layers is not supported by D-WAQ PART), and extended with an analytical vertical velocity profile for bottom shear and wind.
- Oil spill module: simulation of oil spills with floating and dispersed oil fractions.

6.1.2  Physical system

The D-WAQ PART model is used for water quality modelling. D-WAQ PART simulates transport processes and simple chemical reactions of substances. The model can simulate detailed shapes of patches of wasted material.

The physical components in the system are:

- The water system: a lake, estuary, harbour or river, possibly with open boundaries to other water systems. Tidal variations are included.
- Outfalls due to human activities.
- Chemical substances like rhodamine dyes, salt, oil or a demand of oxygen due to fast chemical reactions.
- Wind fields.
- Dissolved and/or particulate substances.

6.1.3  Processes

This section describes the D-WAQ PART model in terms of physical processes or phenomena that the model was designed to represent.

- The dynamics of patches close to an outfall location.
- Simple first-order decay processes like the decay of several fractions of oil.
- Vertical dispersion for well-mixed systems.
- Horizontal dispersion due to turbulence. According to turbulence theory this dispersion increases in time.
- The effects of time-varying wind fields on the patches.
- The effects of bottom-friction on the patches.
- The existence of a plume at the outfall (rather than a point-source) by starting the simulation from a circular plume with an estimated or field-measured radius.
- Settling and resuspension of particles.
6.2 Principles of a random walk particle tracking model

D-WAQ PART is a random walk particle tracking model, which is based on the principle that
the movement of dissolved (or particulate) substances in water can be described by a limited
(large) number of discrete particles that are subject to advection due to the currents and by
horizontal and vertical dispersion. The movement of the particles consists therefore of two
elements. For each time-step, the first step is the advection step due to the shear stresses
from currents (bottom) and wind (surface). The second step is the random walk step in which
the size and direction of the movement is a random process but is related to the horizontal
and vertical dispersion. More details are given in chapter 7.

6.3 Dispersion coefficients

6.3.1 Introduction

The dispersion coefficients are the input parameters for the random spreading processes. In
the horizontal and vertical direction, the dispersion coefficients are treated separately, even
through the numerical treatment is the same.

6.3.2 Horizontal dispersion

The horizontal dispersion coefficient accounts for all of the random fluctuations in the horizon-
tal that are not resolved in the Delft3D-FLOW hydrodynamics. For particle tracking simula-
tions, the horizontal dispersion coefficient is also time dependent. In the initial period of time
after the release of the particles, the patch of particles is relatively small and the mixing of
the particles is caused by small-scale turbulence effects only. However, after some time, the
‘cloud’ of particles will have spread sufficiently such that larger-scale eddies and circulations
will now contribute to the mixing effect.

The dispersion coefficient models the effects of turbulence that were not included in the hy-
drodynamics.

Turbulence model

Turbulent diffusion accounts for small scale deviations from the mean hydrodynamic velocity
field. These deviations are partially correlated and therefore lead to a net extra displacement.
This net extra displacement has a random direction. Therefore it is appropriate to model the
effect as dispersion.

Since D-WAQ PART is a dynamic 3D model dispersion coefficients are small (order 1 m²/s).
The turbulence processes on this scale are time-dependent. We will demonstrate this by
using kinetic gas-theory (Csanady, 1973), describing molecular diffusion $E$:

$$E = \int_0^t \langle \vec{v}(0), \vec{v}(\tau) \rangle d\tau$$

(6.1)

The bracketed term under the integral is named the Lagrangian correlation coefficient. Using
the theory of Brownian motion it can be approximated as:

$$\langle \vec{v}(0), \vec{v}(\tau) \rangle = |v_0|^2 e^{-\tau/t_L}$$

(6.2)

with $t_L$ an appropriate time-scale. This expression leads to a diffusion coefficient of the form:

$$E = v_0^2 t_L (1 - \exp(-t/t_L))$$

(6.3)
Note that the two limits of this function are $E = at$ for large $t$, and $E = a$ for small $t$. In D-WAQ PART it is assumed that the dispersion process can be described in the same way and that the dispersion coefficient can be fitted to a function with a power between these two limits ($0 < b < 1$), which leads to:

For the horizontal direction the dispersion coefficient is defined as:

$$D_{x,y} = at^b$$ (6.4)

with $a$ and $b$ coefficients that follow from calibrating the model (Bent et al., 1991). The time $t$ is defined from $t = 0$, which is the time at which the given particle, for which dispersion is calculated, is released.

**Bed shear stress**

The bed shear stress at any location is calculated from:

$$\tau_b = \rho g \left( u^2 + v^2 \right) \frac{C^2}{C^2}$$ (6.5)

with:

- $\tau_b$: bed shear stress [Pa]
- $\rho$: water density [kg/m$^3$]
- $u$: flow velocity in $x$ direction in the bottom layer [m/s]
- $v$: flow velocity in $y$ direction in the bottom layer [m/s]
- $C$: Chézy coefficient [m$^{1/2}$/s]
- $g$: gravitational acceleration [m/s$^2$]

If the bed shear stress at any location is less than the critical shear stress for sedimentation, a particle that comes into contact with the bottom at that location will remain attached to the bottom (sedimentation). For sedimentation, D-WAQ PART creates an extra model layer for sediment at the bed.

If the bed shear stress at any location is greater than the critical shear stress for sedimentation, a particle that comes in contact with the bottom at that location will be reflected back into the water column.

If the bed shear stress at any location is greater than the critical shear stress for erosion, all deposited particles at that location (i.e. particles located in the extra bed-sediment layer) will be returned to the water column instantaneously.

The settling velocity of each particle at time $t$ is calculated from:

$$v_s = c^n \times \left[ A_0 + A_1 \sin \left( \frac{2\pi (t + \phi)}{T} \right) \right]$$ (6.6)

where:

- $c$: local concentration of particles [kg/m$^3$]
- $n$: exponent for adjusting concentration-dependent settling velocities
- $A_0$: the non-cyclic component of the settling velocity [m/s]
- $A_1$: the amplitude of a periodic sinusoidal variation in time [m/s]
- $T$: the period of the sinusoidal variation [hours]
- $\phi$: the phase lag for the sinusoidal variation [hours]
The factor in front of the square brackets enables you to define a concentration-dependent settling velocity. If the exponent is set to \( n = 0 \), the settling velocity is simply a sinusoidal function of time.

⚠️ Remark:

- For negative values of \( v_s \), the particles will move upwards towards the water surface.

### 6.3.3 Vertical dispersion

In a well-mixed, horizontally uniform flow, the vertical dispersion coefficient may be estimated from the mixing length and the turbulent kinetic energy as:

\[
D_z = \frac{c_{\mu}^{1/4} L \sqrt{k}}{\sigma_C} \tag{6.7}
\]

with:
- \( D_z \) vertical dispersion coefficient [m²/s]
- \( c_{\mu} \) a constant; \( \approx 0.09 \), calibrated for local equilibrium shear layers (Rodi, 1984)
- \( L \) mixing length [m]
- \( k \) turbulent kinetic energy
- \( \sigma_C \) Prandtl-Schmidt number (\( = 0.7 \) for the transport of heat and salinity)

The Bakhmetev (1932) mixing length is estimated by:

\[
L = \kappa (H - Z) \sqrt{(Z/H)} \quad \text{with} \quad Z = -(z - \zeta) \tag{6.8}
\]

with:
- \( \kappa \) von Kármán constant (\( = 0.41 \))
- \( z \) the vertical co-ordinate
- \( \zeta \) the free surface elevation above the reference plan (at \( z = 0 \))
- \( d \) the depth below the reference plane (bed level \( z = d \))
- \( H \) the total water depth, given by \( H = d + \zeta \)

It should be noted that the \( Z \) co-ordinate is pointing downwards, i.e. \( Z = 0 \) is at the surface and \( Z = H \) is at the bottom.

The turbulent kinetic energy is assumed to have a linear profile:

\[
k = k_b \left( \frac{Z}{H} \right) + k_s \left( 1 - \frac{Z}{H} \right) \tag{6.9}
\]

with:
- \( k_b \) turbulent kinetic energy near the bottom
- \( k_s \) turbulent kinetic energy near the surface

The empirical relationships for the turbulent kinetic energy at the bed and at the surface are taken from the \( k-L \) turbulence model used in Delft3D-FLOW. This gives:

\[
k_b = \frac{u_{s_b}}{\sqrt{c_{\mu}}} = \frac{\tau_b}{\sqrt{c_{\mu} \rho_0}}
\]
\[
k_s = \frac{u_{s_s}}{\sqrt{c_{\mu}}} = \frac{\tau_w}{\sqrt{c_{\mu} \rho_0}} \tag{6.10}
\]

with:
Conceptual model

\( \tau_b \)  
bottom shear stress [Pa]

\( \tau_w \)  
wind stress [Pa]

\( \rho_0 \)  
density of water [kg/m\(^3\)]

The shear stresses are derived from the relations:

\[
\begin{align*}
\tau_b &= \frac{g \rho_0 |v|^2}{C_{2D}^2} \\
\tau_w &= \rho_a C_d |w|^2
\end{align*}
\]

with:

\( g \)  
gravity constant (= 9.81 m/s\(^2\))

\( \rho_a \)  
density of air (= 1.25 kg/m\(^3\))

\( C_{2D} \)  
Chézy coefficient for 2D formulations (\( C_{2D} = 50 \text{ m}^{1/2}/\text{s} \); unless specified otherwise in the sedimentation/erosion model)

\( C_d \)  
wind drag coefficient of the free surface

\( |v| \)  
advective velocity (computed from Delft3D-FLOW)

\( |w| \)  
wind velocity at 10 m above the water surface

The resulting vertical dispersion model (known as the \( k-L \) model) is obtained by substituting the above expressions into the expression for the vertical dispersion coefficient to obtain:

\[
D_z(z') = \frac{k}{\sigma_C} H (1 - z') \sqrt{z'} \sqrt{u_{sb}^2 z' + u_{sb}^2 (1 - z')}
\]

where \( z' = Z/H \)

**Figure 6.1** shows an example of the \( k-L \) vertical dispersion coefficient (and its gradient that causes particle drift) for a wind speed of 7.5 m/s.

**Dz and gradient of Dz (dashed)
wind=7.5m/s**

**Figure 6.1:** Vertical dispersion coefficient [m\(^2\)/s] and its gradient (dashed line) as a function of relative depth for the \( k-L \) turbulence model, at a wind speed of 7.5 m/s and a Chézy coefficient of 50.0.
D-WAQ PART does not use space-dependent dispersion coefficients as this would lead to additional stochastic drift terms. From Figure 6.1, it can be seen that particles would drift towards the bottom and the surface and would accumulate there. In order to prevent such non-physical behaviour, the depth-dependency of the vertical dispersion coefficient is eliminated by depth-averaging. D-WAQ PART allows linear scaling of the depth-averaged dispersion coefficient to allow for a reduction in vertical mixing due to stratification in the 3D models.

The depth-averaged relation for $D_z$ is obtained by integrating the above expression to obtain:

$$D_z = \frac{\kappa H}{\sigma C} \int_{z'=-\infty}^{z'=0} \sqrt{u_{z'}^2 (1 - z')^2 + u_{s_z}^2 (1 - z')^3} \, dz'$$

$$\approx \frac{\kappa H}{\sigma C} \left[ \int_{z'=0}^{z'=1} \sqrt{u_{s_z}^2 z'^2 (1 - z')^2} \, dz' + \int_{z'=-\infty}^{z'=0} \sqrt{u_{s_z}^2 z'^2 (1 - z')^3} \, dz' \right]$$

(6.13)

6.4 3 Dimensional flow field

D-WAQ PART is a 3D-model. A 3D hydrodynamic flow field is obtained from a 3D Delft3D-FLOW hydrodynamic simulation (operation in mode 1) or by superimposing a logarithmic velocity profile over depth for the bottom shear on a 2DH Delft3D-FLOW (operation in mode 2) simulation and a parabolic profile over depth for wind. In this section the velocity profiles for 2DH calculations are discussed:

**Logarithmic profile for bottom shear**

The logarithmic profile for bottom shear is given by:

$$v_z = C \ln \left( \frac{H - Z}{Z_0} + 1 \right) \times v$$

(6.14)

where $C$ is:

$$C = \left[ \left( 1 + \frac{Z_0}{H} \right) \ln \left( \frac{H}{Z_0} + 1 \right) - 1 \right]^{-1}$$

(6.15)

with:

- $v_z$: vertical profile of the horizontal velocity
- $Z$: depth co-ordinate (from 0 (surface) to $H$ (bottom))
- $H$: water depth
- $Z_0$: roughness length
- $v$: depth-average velocity

The roughness length is of the order 2 cm. The depth-averaged velocity is obtained from a 2DH-version hydrodynamic program (Delft3D-FLOW).

**Parabolic profile for wind**

The parabolic profile for wind is given by:

$$v_z = \alpha \left( 3 \left( 1 - \frac{Z}{H} \right) - 2 \right) \left( 1 - \frac{Z}{H} \right) W$$

(6.16)

with:
Wind speed at 10 m above sea level
wind drag coefficient

The wind-drag coefficient is typically in the order of 0.03. The integral over depth is zero and is superimposed on the normal velocity profile which already includes the gross average influence of the wind. This gross wind effect on the velocity field must have been incorporated in the 2DH-hydrodynamic velocity field.

6.5 Oil spill module

The D-WAQ PART Oil Spill model calculates the transport, spreading, evaporation and dispersion of an oil patch. Transport is either 2D or 3D. Oil can either be floating on the water surface, or it can be transported as a dispersed phase in the water column. Oil dispersion, also referred to as entrainment, is generated by breaking waves (due by wind) according to a formulation of Delvigne et al. (1986). Evaporation is based on a simple first order decay process.

Release of oil

Oil can be spilled as an instantaneous release or as a continuous release. The radius of an instantaneous release may follow from the standard input menu of the release, but may also be specified by the following formulation (Fay and Hoult, 1971):

\[
R_0 = \frac{k_2}{k_1} \left( \frac{V_0^5 g (\frac{\rho_w - \rho_0}{\rho_0})}{\nu_w^2} \right)^{1/12}
\]

with:
- \(V_0\): initial volume of the oil spill [m\(^3\)]
- \(\rho_0\): oil density [kg/m\(^3\)]
- \(\rho_w\): density of water [kg/m\(^3\)]
- \(g\): gravity constant
- \(\nu_w\): kinematic viscosity of water [10\(^{-6}\) m\(^2\)/s]
- \(k_1, k_2\): constants of Fay (1.14 and 1.45)

You should specify the oil density \(\rho_0\) as input. The radius describes a patch after the so-called ‘gravity inertial phase’ which lasts in the order of 5 minutes for most spills. The thickness of the floating patch is then usually less than 1 mm. It is not recommended to use this description for continuous releases, but to specify the radius of the release according to the information that is available.

Wind induced advection of surface oil

The advection of surface floating oil is subject to wind effects. This is widely published in literature. For example, Labelle and Johnson (1993) carried out simulations of oil-spill trajectories for which each trajectory was constructed using vector addition of the current field and 3.5 percent of the instantaneous wind. A drift angle was computed as a function of wind speed (inversely related to wind speed). In a review by the Task Committee on Modelling of Oil Spills of the Water Resources Engineering Division (1996), it has been reported that the majority of spill models use a simplified linear superposition technique to approximate spill motion. The currents induced by winds and waves are normally lumped together and represented by an empirically based drift factor and deflection angle dependent on the local wind speed and direction. Drift speeds typically vary from 2.5–4.4 % of the wind speed. The deflection angles vary between 0 and 25 degrees to the right/left of the wind direction (northern/southern
hemisphere). The most detailed description of drift of oils is given by Yousseff and Spaulding (1993). Here also the drift speed is specified as typically between 2.5 and 4 % of the wind speed with a mean value of 3.5 %, and deflection angles between 0 and 25 degrees, with a mean of 15 degrees. Yousseff and Spaulding (1993) deal in detail with the effects of waves on the transport.

A representation of the effect of wind in D-WAQ PART is implemented for oil. For a reasonable behaviour of surface floating oil under windy conditions, it is essential for the wind to affect the advection of the surface floating oil. The most important effect is drift as a percentage of the wind speed. The relationship that describes this effect is specified as

\[ C_{wd} (V_w - V_f) \] (6.18)

with \( C_{wd} \) the wind drag, \( V_w \) the wind speed and \( V_f \) the current speed. This relationship is only applied to surface floating oil because the dispersed oil will be transported correctly by the currents of the hydrodynamic model and not be directly influenced by wind.

Another factor that affects the transport of the oil is governed by the aforementioned deflection angle, which is an angle between the wind direction and oil advection. This is essentially caused by the fact that the effects of the waves is under the influence of Coriolis and that the wave induced transport is at an angle of the wind. This angle is an empirical parameter. This parameter is chosen to be a constant and it is therefore assumed that the angle does not depend on the wind speed. The deflection angle will depend on the latitude. The deflection angle is included in the PART model as an additional parameter. The deflection angle would therefore essentially be a calibration parameter, depending on latitude and wind strength.

The drift of the surface oil is implemented in the 3-dimensional mode. When the flow is in a 2D mode, the advection by wind drift at the surface is included in the vertical profile that is derived in D-WAQ PART (see section 6.4), thus an additional wind drift is not required.

**Evaporation of oil**

Evaporation of floating oil is implemented as a first order decay process. Decay can be specified by a decay constant as usual in the menu of process parameters (this can be done with a time-series), or by defining a fixed fraction of oil that decays each day.

It is known that oil contains fractions that do not evaporate. For example, Reed (1989) adopted in his model a mass transfer coefficient that uses the molecular weight of the volatile fraction of the oil spill.

In the oil module of PART, a volatile fraction has been introduced, albeit simplified compared with the implementation of Reed (1989). It is assumed that the volatile fraction \( F_{vol} \) evaporates as a first order process (i.e. exponential), and that the non-volatile fraction does not evaporate at all. This is achieved by the introduction of the following:

\[ \frac{dF_v}{dt} = - \left( \frac{F_{vol} - F_v}{1 - F_v} \right) k \] (6.19)

Where \( F_v \) is the evaporated fraction and \( k \) the evaporation rate constant. The numerator in the equation should always be positive and if \( F_{vol} - F_v < 0 \) then the evaporation is set to zero.

The oil viscosity will change during the evaporation process. In the literature, descriptions of the dependency of the viscosity as a function of the evaporated fraction exist and is generally
Conceptual model

\[ \eta = \eta_0 e^{(C_v F_w)} \quad (6.20) \]

This equation is given for the dynamic viscosity. Assuming that the density is approximately constant throughout the simulation, then the same function can be used to describe the kinematic viscosity. Reed (1989) states that the value of \( C_v \) in his model is equal to 1 for gasoline, kerosene and light diesel fuel and 10 for other petroleum products. In the PART model, this is implemented by assuming that \( C = 1 \) is used for light oils (kinematic viscosity less than 500 cSt) and \( C = 10 \) for the heavy oils (viscosity greater than 500 cSt).

**Dispersion (entrainment) of oil**

Dispersion of floating oil, or entrainment of oil in water, is implemented as a zero order decay process, i.e. the entrainment rate is independent of the floating oil concentration. The dispersion rate of oil depends only on the wave energy that is dissipated by the patch, and the type of oil.

The dispersion rate \( Q \) [kg/(m²/s)] of oil is given (see Delvigne and Sweeney (1988); NOAA (1994); Delvigne and Hulsen (1994)) by:

\[
Q = \int_{d_{\text{min}}}^{d_{\text{max}}} Q(d) \, \mathrm{d}d
\]

\[ Q(d) = C'' D_0^{0.57} F_{wc} N(d) d^3 \]

\[ N(d) = N_0 d^{-2.3} \]

\[ D_e = 0.0034 \rho_w g H_0 / \sqrt{2} \]

\[ H_0 = \frac{0.243 U_w^2}{g} \]

\[ F_{wc} = \frac{f_w}{t_p} \]

\[ t_p = 8.13 \frac{U_w}{g} \]

\[ f_w = \max(0.0, 0.032(U_w - 5.0)) \]

with:

- \( Q \): dispersion rate [kg/(m²/s)]
- \( Q(d) \): dispersion rate per unit of diameter for droplets of diameter \( d \) [kg/(m²/s)]
- \( d \): oil droplet diameter [m]
- \( d_{\text{min}} \): minimal oil droplet diameter [m]
- \( d_{\text{max}} \): maximal oil droplet diameter [m]
- \( C'' \): oil constant (calibration parameter, depending on kind of oil)
- \( N(d) \): oil particle size distribution function
- \( N_0 \): normalisation constant distribution function
- \( D_e \): dissipation of wave energy per unit surface area [J/m²]
- \( F_{wc} \): number of waves that break per wave period [-]
- \( t_p \): peak wave period [s]
- \( U_w \): wind speed [m/s]
- \( f_w \): fraction of sea covered by white caps [-]

Here, white capping is formulated according to Holthuijsen and Herbers (1986) with the initial wind speed for white capping equal to 5 m/s. The minimal droplet size \( d_{\text{min}} \) can be taken zero.
as a good approximation. The crux is knowledge of parameters $d_{\text{max}}$, $N_0$ and the calibration constant $C''$. According to NOAA (1994), after resurfacing of particles back into the oil slick, $d_{\text{max}}$ can be taken equal to 70 microns. In this approximation, it is assumed that after each breaking wave a quasi-steady state distribution of droplets results, i.e. the resurfacing of particles back into the oil slick due to buoyancy goes fast compared with the dissipation of wave energy by the oil slick. Defining a new calibration constant $C_0$ the following expression results for $Q$:

$$Q = 5.08 \cdot 10^{-8} C_0 S_{\text{cov}} D_e^{0.57} F_{w_{\text{ic}}}$$  \hspace{1cm} (6.22)$$

with

- $Q$: dispersion rate [kg/(m$^2$/s)]
- $C_0$: oil constant (calibration parameter)
- $S_{\text{cov}}$: proportion of the sea surface covered by the oil in the relevant area
- $D_e$: dissipation of wave energy per unit surface area [J/m$^2$]
- $F_{w_{\text{ic}}}$: number of waves that break per wave period [-]

The calibration parameter $C_0$ depends on the kind of oil: oil with a high viscosity disperses hardly for a wind speed of 10 m/s whereas oil with a low viscosity disperses fast for such a wind speed.

An order of magnitude of $C_0$ follows from Delvigne and Hulsen (1994) (Table 2 and Figure 4 of that publication). Since Delvigne and Hulsen do not take into account a steady state assumption their values can only be a first estimate for D-WAQ PART. Estimates of the dispersion constant $C_0$ are:

- $C_0 \approx 2000$ for Ekofisk with standard oil viscosity $\nu = 8$ cSt (at 20 $^\circ$C)
- $C_0 \approx 50$ for Heavy Fuel Oil with standard oil viscosity $\nu = 3000$ cSt (at 20 $^\circ$C)

Since viscosity is temperature dependent $C_0$ depends both on oil type and on temperature. Temperature dependence may be neglected for low viscous oils with $\nu < 100$ cSt (Delvigne and Hulsen, 1994).

Delvigne and Hulsen (1994) have shown that there is a relationship between the $C_0$ and the oil viscosity. Since viscosity is an oil characteristic and used as input of the model, this relationship is included in the model. The relationship used in the modified PART(Oil) model is based on the data published by Delvigne and Hulsen (1994). The data was examined and a log-log plot revealed that this relationship can be specified by two equations (Figure 6.2). The equations used and the goodness of fit with the data are indicated in the figure.

In order to calculate the entrainment flux, some representation of surface area for each surface oil particle is required. In the oil module an area for each particle is derived, based on the mass of surface oil associated with this particle (WL | Delft Hydraulics, 2003). This is calculated using an assumed oil layer thickness. Validation with the oil budget model ADIOS has resulted in an optimal value of 0.00005 m. This value of 0.05 mm (50 $\mu$m) is also similar to the value of 70 $\mu$m generally used to define the oil droplets that remain in suspension.
Emulsification

Water-in-oil (w/o) emulsions form a viscous cream, or floating, coherent semi-solid lumps, often called chocolate mousse. The process depends on oil composition. The formation of w/o emulsions reaches a maximum between 10 and 100 hours (Wheeler, 1978). The emulsification process itself is relatively rapid. It has been reported that emulsification takes place fully in the laboratory in 0.1–3 hours (Fingas et al., 1999).

Emulsification is virtually an irreversible process (Wheeler, 1978) and changes the liquid to a heavy, semi-solid material (Fingas and Fieldhouse, 1996) with a high viscosity. Viscosity can be as high as $4 \cdot 10^6$ cP (Bos, 1980).

The emulsification process is implemented in PART following the algorithm presented by Mackay and others (Mackay et al., 1980; Zagorski and Mackay, 1982), in which the rate of water uptake $\tilde{F}_{wc}$ is given by:

$$\tilde{F}_{wc} = C_1 (U_w + 1)^2 \left( 1 - \frac{F_{wc}}{C_2} \right)$$

(6.23)

with $U_w$ the wind speed, $F_{wc}$ the water content and $C_1$ and $C_2$ model parameters. $C_1$ is given as $2 \cdot 10^{-6}$ for emulsifying oils and 0 for others, whilst $C_2$ is a constant controlling the maximum water content and is suggested to be 0.25 for home heating oil and 0.7 for crude and heavy fuel oil (Reed, 1989). In several other publications, however, the maximum water content for these heavy oils is said to reach values of 75–80% (for example, Huang (1983)). The switch of $C_2$ between 0.25 and 0.75 is made at a viscosity of 500 cSt, whilst the value of $C_1$ (0 or $2 \cdot 10^{-6}$) is selected by the user and thus dependent on the emulsion formation tendency of the oil in question.

The main effect of emulsification (increase in the water content) in the model is the change in viscosity and is given as:

$$\frac{\mu}{\mu_0} = e^{\left( \frac{2.5 F_{wc}}{1.0 - C_2 F_{wc}} \right)}$$

(6.24)
As with the change of viscosity as a function of the evaporated fraction, it is assumed that the density does not change significantly, compared with the changes in viscosity and is assumed constant. Thus the implementation in the PART(Oil) model uses the kinematic viscosity in the aforementioned equation instead of the dynamic viscosity. The constant $C_3$ is suggested to be 0.65 (Reed, 1989).

Emulsification does not only affect viscosity (and therefore the dispersion (entrainment) process) but also evaporation. According to Fingas (1994), the effect of emulsification is that the viscosity rises two to three orders-of-magnitude, the spreading rate decreases by a similar value and evaporation nearly ceases.

In order to achieve a link between the emulsification and evaporation in PART(Oil), the water content of the emulsion is used to reduce the evaporation rate. In the implementation in PART, it is assumed that the evaporation ceases when the water content has reached its maximum. This maximum water content is oil type dependent. The evaporation rate is adapted when emulsification occurs by reducing the volatile fraction. This is implemented as follows:

$$F_{ew} = \frac{C_2 - F_{wc}}{C_2} F_{vol}$$  \hspace{1cm} (6.25)

Where $F_{vol}$ is the volatile fraction of the spilled oil and $F_{ew}$ the adapted volatile fraction, replacing the volatile fraction $F_{vol}$ in Equation (6.19). Thus, when the water content reaches its maximum $C_2$, the adapted volatile fraction reduces to zero and the evaporation halts.

The onset of emulsification can be delayed until evaporation causes the oil characteristics to reach the criteria for emulsification. This delay has been implemented in PART(Oil) by introducing a fraction evaporated oil at which emulsification is initiated ($E_v$).

**Oil density**

The density of the oil is affected by evaporation and emulsification. Density is also a function of temperature. In PART, the ADIOS formulation is used, without the dependency of the evaporated fraction and temperature. Hence, in PART, the density can only change when the oil emulsifies. The density is then a linear interpolation of the densities of water and oil, according to their relative content:

$$\rho_{em} = F_w \rho_w + (1 - F_w) \rho_{oil}$$  \hspace{1cm} (6.26)

where

- $\rho_{em}$: Density emulsion [kg/m$^3$]
- $F_w$: Water fraction
- $\rho_w$: Water density [kg/m$^3$]
- $\rho_{oil}$: Oil density [kg/m$^3$]

**Sticking of oil**

Oil may stick to land and cause damage to ecological sites. In order to simulate the process of oil sticking to land or to the bed of the water column, a sticking probability must be specified. A particle may come into contact with land due to wind effects or horizontal dispersion and it may come into contact with the bed due to vertical dispersion or settling. The particle sticks to the land or bed if a randomly chosen number between 0 and 1 is smaller than the sticking probability given.
Settling of oil particles

Dispersed oil may settle. However, this velocity is generally negative since oil particles are lighter than water. Most oil and refined products are less dense than water, which means they will float when initially spilled. Experience has shown that oil slicks that initially float will remain buoyant even after weathering. The two circumstances under which oil has been noted to sink occur when the oil is mixed with mineral sediment in the water column or when it is burned in-situ, creating a residue that may be of high density.

Weathering of oil

In addition to the processes mentioned earlier, other weathering processes may affect the presence of oil. Processes such as oxidation, bacteriological decay can in part be simulated by means of a first order decay, for which a decay parameter can be specified.

6.6 Data requirements for the conceptual model

A list of data that enter the conceptual model and pertain to the physical system that is being modelled will be described in this section. Assumptions are made about the sensitivity of the model results for these parameters. These assumptions are general remarks and their importance strongly depends on the accuracy required by you for giving you enough insight in the particular water quality problem at hand.

1 Hydrodynamic database of volumes and flows

<table>
<thead>
<tr>
<th>Source</th>
<th>Meaning</th>
<th>Sensitivity</th>
</tr>
</thead>
<tbody>
<tr>
<td>supplied by the coupling module after a Delft3D-FLOW run</td>
<td>determines the advective transport and the amount of water available for dilution of the wasted substance</td>
<td>should be accurate, especially for the calibration of dye experiments</td>
</tr>
</tbody>
</table>

2 Wind drag coefficient

<table>
<thead>
<tr>
<th>Source</th>
<th>Meaning</th>
<th>Sensitivity</th>
</tr>
</thead>
<tbody>
<tr>
<td>user-defined</td>
<td>parabolic wind profile over depth (2D flow field); drag on surface oil (Oil module).</td>
<td>anisotropy of a patch for a dye experiment depends on this parameter (range 1 %–5 %). Experience at Delft Hydraulics learns that a value of 1 % is mostly used for D-WAQ PART applications rather than the 3 % recommended by literature. This may be due to the D-WAQ PART algorithm (parabolic profile and depth-averaged vertical dispersion coefficient).</td>
</tr>
</tbody>
</table>

3 Wind field

<table>
<thead>
<tr>
<th>Source</th>
<th>Meaning</th>
<th>Sensitivity</th>
</tr>
</thead>
<tbody>
<tr>
<td>user-defined</td>
<td>describes parabolic wind profile for 2D FLOW velocity field, used in the 2DH approach. If the depth-averaged vertical dispersion option is selected, then the wind is also used to calculate the vertical dispersion. For the oil module, the wind is used to calculate the entrainment flux of the oil into water.</td>
<td>the average direction and wind speed should be a reasonable estimate</td>
</tr>
</tbody>
</table>

4 Deflection angle (3D)

<table>
<thead>
<tr>
<th>Source</th>
<th>Meaning</th>
<th>Sensitivity</th>
</tr>
</thead>
</table>
| user-defined (literature value), depending on latitude | describes the angle between the wind direction and oil advection. | The deflection angle is generally between 0 and 25 °rotating to
the right on the northern hemisphere and to the left on the southern hemisphere.

5 Roughness length (2DH model)

Source user-defined (literature value)
Meaning describes logarithmic profile due to bottom shear for 3D velocity field
Sensitivity a value of 2 cm is recommended

6 Dispersion parameters a and b for horizontal dispersion

Source user-defined
Meaning determines the increase of the horizontal dispersion coefficient with time.
Sensitivity the parameter a is most important for the short-time range whereas b is most important for the long-time range. The value of the parameters depends on the amount of detail (turbulence) not incorporated in the hydrodynamics. The parameters should follow from calibration or from an expert opinion.

7 Amount of released material

Source user-defined
Meaning an instantaneous release (mass) or a continuous release (release rates and concentrations or, alternatively, mass rates).
Sensitivity quantitative results depend linearly on the accuracy of these input data

8 Time and location of released material

Source user-defined
Meaning -
Sensitivity should be accurately known

9 Constants oil spill module

Source user-defined, including oil-viscosity, from which the dispersion (entrainment) parameter is derived, see Delvigne and Hulsen (1994). A stickyness probability is important for sticking of oil to land or the bed. All oil model parameters are related to the oil characteristics. Oil characteristics are available from oil databases.
7 Algorithmic implementation

7.1 Introduction

For each particle, transport is split in a part for advection and a part for wind and horizontal and vertical dispersion. Dispersion and advection of clouds of particles are treated with different numerical schemes. These schemes are described in this section.

7.2 Advection schemes

The advective part is solved with an analytical integration procedure that integrates exactly a linearly interpolated hydrodynamic velocity field. The advective velocity of a particle is obtained by linear interpolation of the velocities at the borders of the computational cells of the grid of the hydrodynamic simulation. A vertical velocity profile is added to the interpolated velocity field. The path of a particle in a computational grid-cell is determined by analytical integration along the velocity field. This procedure leads to mass-conservation of water. The analytical integration method automatically deals with closed (land) boundaries correctly, since velocities vanish asymptotically at the borders. Particles that pass open (water) boundaries are taken out of the calculation.

The analytical integration procedure is given by:

\[ x(t + \Delta t) = x(t) + \int_0^{\Delta t} \left( \frac{dx}{dt} \right) dt \]  \hspace{1cm} (7.1)

with:

- \( x \) is the distance
- \( t \) is the time
- \( \frac{dx}{dt} \) is the velocity in \( x \)-direction

\[
x = x(s(t)) \\
\frac{dx}{dt} = \frac{ds}{dt} (\alpha_x x(s) + \beta_x) \\
\alpha_x = C(\sigma) \left( \frac{Q_+ - Q_-}{V} \right) \\
\beta_x = C(\sigma) \frac{Q_{+/-}}{V}
\]  \hspace{1cm} (7.2)

with:

- \( s(t) \) is the streamline distance function
- \( \alpha x(s) + \beta \) is the linearly interpolated velocity in the grid along the stream line
- \( Q_{+/-} \) is the flow though the upwind or downwind surface of the grid cell
- \( V \) is the volume of the grid cell
- \( C(\sigma) \) is the distance between the velocity points in the hydrodynamic grid
- \( \frac{1}{V} \) is \( 1/\)travel time of the grid cell with this \( Q_{+/-} \)

For the implemented numerical integration, the path acceleration is neglected:

\[ \frac{ds}{dt} = 1 \]  \hspace{1cm} (7.3)

This flow field is exactly related to the hydrodynamic flow field (Delft3D-FLOW).
The flow field is conservative if:

\[ \frac{\partial}{\partial x} (\alpha_x x + \beta_x) = 0 \]  \hspace{1cm} (7.4)

and for coupling to Delft3D-FLOW this condition is satisfied.

7.3 Dispersion schemes

The dispersive part is solved with an Euler-type numerical scheme. In the horizontal direction also additional advection due to wind (in 2DH mode) is handled with this numerical scheme. In vertical direction a displacement due to settling can be added to the vertical displacement due to dispersion. Boundary conditions are handled simultaneously for these two schemes and are purely reflective.

Dispersion in both the horizontal and the vertical direction is based on a white noise process with a uniform probability density function with zero mean ranging between -1 and +1. The maximum displacement of each particle for each time-step is then:

\[ \Delta S = \sqrt{6D\Delta t} \]  \hspace{1cm} (7.5)

It is noted here that none of the three dispersion coefficients is allowed to be 0, since this will reduce the numbers of degrees of freedom which will affect the specification of the displacement.
References


A Input files D-WAQ PART

A.1 Introduction

The particle model gets its information from the hydrodynamic model (Delft3D-FLOW) and a user input file. An input file is normally generated by the Graphical User Interface (GUI) but may also be edited directly using any text editor. However, you should always be careful when editing the input file directly, since inconsistencies in the input that would not be possible when using the GUI, may lead to unexpected results, without generating appropriate error messages.

This appendix describes the main ASCII input file for D-WAQ PART. In addition to this input file, PART also requires the file `<runid.mdp>` (see section 3.4.3) and the hydrodynamics files generated by the coupling program.

If the oil module is selected and initial condition is specified, an external initial condition file `<*.ini>` will be required. The format of this file is in Section A.6.

A.2 General set-up of the input file

Formats

The user input file is free formatted. You may insert information anywhere on lines and may insert comment lines or comments on data lines in the following way:

- All information after a semicolon (`;`) is treated as comment, the semicolon included. (This holds also for semicolons in character fields!)
- Blank lines are skipped and may be used freely.
- Character strings must be supplied in quotes.

The FORTRAN language may (sometimes) have problems with two subsequent leading zeros in a number, so it is advised not to use multiple leading zeros in the free formatted input.

Errors in input

The input program checks as much as possible for wrong input. It is advised to review the input and run report file carefully. Error messages are not given on screen but only given in the report file, so always check the report file!

Specification of time functions

Time-functions are always specified by a number of breakpoints (days, hours, min, sec), followed by a value for that breakpoint. The program requires the first breakpoint of the time-series to be the same as the start of the simulation and the last breakpoint to be the same as the end of the simulation.

By default, the program carries out a linear interpolation between the break points for all specified time-functions. The program can mimic block functions by specifying two subsequent records with equal time and distinct values. For continuous releases you can select a block function or linear interpolation of the time-function.
**Information in the input file**

In this section the input file for model type 2 — oil simulation — is defined (2.5 DH or 3D modes). In the explanation of the input file the following symbols are used:

- this item must be specified on a new line.

* this item must be specified in the input line on the same line as the last line starting with a `-`.

Δ indicates that this input is optional, or its use is only required when some other variable indicates this (since it is > 0).

**ASCII Input file (definition of):**

```
'V3.66.00' ; please, don’t change this line

'Tutorial \DPART’
‘Friesian Tidal Inlet model’
‘Ekofisk and HFO release’
‘T0: 1990.08.05 00:00:00 (scu = 1s)’
```

- **Run identification.**
  The run identification consists of 5 strings of at most 40 characters. The first line is required and identifies the PART version number that is used. This line should not be changed since the model will not run when the version number in the input file is not consistent with that of the model. The subsequent 4 lines are for information purposes and are used on the graphical output. Do not put any quotes in the strings since this will lead to blocking errors that are difficult to trace back.

```
; Hydrodynamics file (*.hyd)
'com-tut_fti_part.hyd'; name of *.hyd file
```

- **Name of Delft3D <*.hyd> file (see section 3.4).**
  This filename consists of at most 80 characters. The file needs to be located in the working directory. The file is generated by the coupling program and contains all the input and output filenames, including the ASCII input file discussed here. It should be noted that the information in the <*.hyd> file is used by the PART-GUI. When the GUI is exited the <filename.dat> file is generated. This file includes the filenames and locations of the hydrodynamics that will be used. Thus when executing D-WAQ PART, the information from the <filename.dat> file is used, and not the <*.hyd> file.

```
; Numerical parameters
; Type of model: 1 - tracer (basic module)
; 2 - (obsolete option)
; 3 - (obsolete option)
; 4 - oil model
; 5 - (obsolete option)
4 0 0 0 ; type of model tracks(0/1) extra_output(0/1) sed/erosion(0/1)
```

- **An integer specifying the model-type (or ‘mode’) — see section 3.4.**

  * An integer specifying whether particle tracks for all particles are generated in the output. A value of 0 indicates no particle tracks output. It is recommended to keep the number of particles in the model small (e.g. less than 1 000), because the output file can become very large if a large number of particles is used. When the number of particles is greater than 1 000, a warning is generated.

  * An integer that is no longer used, but is required in the input file.

  * An integer specifying whether sedimentation/erosion processes are switched on (1) or off (0).

```
1 900 ; num. scheme time step(s) (0=flow time step)
```

- **An integer indicating the numerical scheme for advection of the particles (option 1 is the only option available).**
An integer indicating the time-step in seconds. A value of ‘0’ means that the time-step will be the same as that of the hydrodynamic database.

1 0.10 0 ; vert. disp option(*) scale disp_coeff.(m2/s)
; (*) 0=constant l-depth averaged

- An integer indicating the numerical scheme for vertical dispersion of the particles.
  For the recommended option 0, a constant vertical dispersion parameter is used. For option 1 this parameter follows from an algebraic $k - L$ model.

- A real indicating a scale factor for vertical dispersion.
- A real indicating a vertical dispersion constant when dispersion option ‘0’ was used.
  When option ‘1’ is used this value is not used.

- An integer specifying the total number of substances.

- Substance name.
  For each substance, a string of 20 characters (maximum) must be given. For the oil spill module, for each oil fraction, specify 3 names in the following order:

1 Name of the floating Oil, e.g. ‘Ekofisk’;
2 Name of the dispersed Oil, e.g. ‘Ekofisk dispersed’;
3 Name of the Sticking Oil, e.g. ‘Ekofisk sticking’.

Because of this, we advise to use a substance name with a maximum of 10 characters each, so that the sub-types dispersed and sticking can be added.

- Number of particles.
  You may select the total number of particles to be used. More particles results in a more accurate solution of the mathematical equations (not necessarily in a better simulation) and a better resolution of the concentration, but in a longer computation time. The maximum number of particles is limited by the memory of your computer.

Please note that this number is not necessarily the total number of particles used in the simulation. This is because the total number of particles in the simulation will be the sum of all percentages of particles that is specified for every release (continuous and instantaneous) multiplied by the specified number of particles. Thus the number entered here represents a total release of 100 % of the particles (see instantaneous and continuous releases).

- Roughness length [m].
  The roughness length parameter is one of the calibration constants (see the report concerning the principles of the model). It is advised to take something like 0.02 m. This constant is only used when D-WAQ PART runs in 2DH mode, but must also be supplied for 3D calculations.
- Isotropic dispersion coefficients \([m^2/s]\).
  This constant \(a\) is also subject to calibration. See section 6.3 for details.

- Exponent for horizontal dispersion coefficients.
  This constant \(b\) is also subject to calibration. See section 6.3 for details.

- Wind drag coefficient [%].
  This constant represents the velocity of the top most water layer as a percentage of the wind velocity (e.g. 3.0 means 3 %). For the tracer module, this constant is only used when D-WAQ PART runs in 2DH mode, even though it must also be supplied for 3D calculations. The value is also used by the oil module for the transport of the surface floating oil (2DH and 3D mode).

- Density of water \([kg/m^3]\).

-Wind parameters

<table>
<thead>
<tr>
<th>dd</th>
<th>hh</th>
<th>mm</th>
<th>ss</th>
<th>speed(m/s)</th>
<th>direction(degr.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 12</td>
<td>30</td>
<td>0</td>
<td>6.000</td>
<td>270.000</td>
<td></td>
</tr>
<tr>
<td>0 20</td>
<td>30</td>
<td>0</td>
<td>6.000</td>
<td>270.000</td>
<td></td>
</tr>
</tbody>
</table>

- the number of “breakpoints” for the time function as an integer.
  That number of records consisting of:

  - 4 integers giving the time of a function point (day, hour, minute, second), followed by
    2 reals indicating the wind speed \([m/s]\) and the direction (degrees from the North, e.g. 270 degrees is from the West).

At least two breakpoints should be given (also for zero wind velocities). The start time and end time of the series of breakpoints (which must be a series increasing in time) should be equal to the start time and stop time of the total simulation.

Model specific parameters

Oil model parameters

- model specific constants (real).
  For the tracer model, there are no additional constants and 0 should be entered. For the oil module additional constants are required.

\(\triangle\) That many records specifying the values of the constants (only required for the oil module, see section 6.3.

Timers

<table>
<thead>
<tr>
<th>yyyy</th>
<th>mm</th>
<th>dd</th>
<th>hh</th>
<th>mm</th>
<th>ss</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 12</td>
<td>30</td>
<td>0</td>
<td>0  0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0 20</td>
<td>30</td>
<td>0</td>
<td>0  0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0 12</td>
<td>30</td>
<td>0</td>
<td>0  0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0 20</td>
<td>30</td>
<td>0</td>
<td>0  0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0 1</td>
<td>0</td>
<td>0</td>
<td>0  0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

- Simulation timers (days, hours, min, sec).
  Two sets of 4 integers, expressing the day, hour, minute and second of the start and the stop of the simulation. The start time must be the same as the start time of the coupled hydrodynamic output file. This is tested by the system. The end time may exceed the end time of the coupled hydrodynamic simulation. In that case, the hydrodynamics database is rewinded automatically and re-used.

- D-Water Quality delay time (days, hours, min, sec).
  One set of 4 integers defining day, hour, minute and second. This option is no longer
supported in the GUI and it is required to set the 4 integers to 0, otherwise unexpected results may occur.

- Map file timers (days, hours, min, sec).
The map file is used for movie generation (as with the D-Water Quality map file). Three sets of 4 integers must be provided, giving the day, hour, minute and second of the start of the map file, the stop of the map file and the time step in the map file. This output generates concentration distributions mapped on the hydrodynamic grid (optionally aggregated in the vertical).

- Time history file timers (days, hours, min, sec).
The time history file is used for time histories that can be plotted with GPP. Three sets of 4 integers must be provided, giving the day, hour, minute and second of the start of the file, the stop of the file and the time step in the history file. In this file a time-series of concentrations is given at specified observation points (‘monitoring stations’), specified below.

- Time offset (year, month, day, hour, min, sec).
To map the model time to real world timings, 6 integers must be provided for the year, month, day, hour, minute and second to be added to the model time to obtain the real world time.

; Observation points
1
‘waste point’ 13210.00 14000.00

- An integer giving the number of observation points, also called ‘monitoring stations’.
The observation points are used to generate time histories that can be plotted in GPP (see also the block ‘timers’ discussed above).

\[\Delta\] For each observation point supply one line with three items, namely:

- a string of at most 20 characters giving the name of the observation point.
- the x-co-ordinate and y-co-ordinate of the observation point. The co-ordinates must be consistent with the co-ordinate system of the hydrodynamic simulation.

NOTE: the z-co-ordinate of observation points need not be supplied since in 3D simulations always concentrations for all layers will be given in the history file.

; Output parameters
; Zoom grid output method
8
; dd hh mm ss recovery(-) (for scaling of output)
0 12 30 0 1.000
0 12 45 0 1.000
0 13 0 0 1.000
0 14 0 0 1.000
0 16 0 0 1.000
0 18 0 0 1.000
0 20 0 0 1.000
0 20 30 0 1.000

- Number of times to generate output using the zoom grid for concentration generation. The principle of using the zoom grid is explained in Figure 4.12.2. What essentially is done is to add the mass of all the particles in one grid cell of the zoom window and to calculate the concentration by dividing this mass by the volume of the cell. This is done for all cells in the zoom window (all layers).

\[\Delta\] For every time, for which output using the zoom grid window is generated, 4 integers and 1 real must be provided. The integers specify the output times (in day, hour, minute, second). The real gives the recovery factor. A recovery factor of 1.0 yields concentrations as modelled. A different recovery factor may be used to match the model results to measured data, if not all material is recovered with the measurements.
Zoom grid output parameters

5000.00  20000.00 ; x-start (m) x-end (m)
10000.00  25000.00 ; y-start (m) y-end (m)
150  150 ; grid cells in x dir (-) grid cells in y dir (-)

- x-co-ordinates of the zoom window.
- y-co-ordinates of the zoom window.

These values define the location and size of the zoom window. Output using the zoom grid output method will be limited to this window and if particle stray outside this window they will not be shown, even though these particles remain active in the model. The co-ordinates are all expressed in the same units as used in the hydrodynamic computation (for example national grid co-ordinates).

- Two numbers (integers) defining the number of grid cells in the x- and y-direction respectively.

Instantaneous releases

'dye release 1'
0  12  30  0 ; release time (dd hh mm ss)
13210.00  17300.00  1 ; x-coord (m) y-coord (m) layer (-)
0  0.00 ; option for release radius radius [m]
50.00 ; perc. of total particles (%)

released mass (kg)
1.000e+008 ; Tracer
0.000 ; Tracer con 52

- Number of instantaneous releases.

that many sets as instantaneous releases consisting of:

- a string containing the name of the release (at most 20 characters).
- 4 integers for the release time (day, hour, minute, second).
- 2 reals for the x- and y-co-ordinates of the release point (use the same co-ordinate system as the hydrodynamic grid).

* (on the same line) one integer giving:
  a for \( K > 0 \): the layer of the release. For dye releases the particles are uniformly distributed over the layer;
  b for \( K = 0 \): a uniform release over depth.

- 1 integer to indicate if the radius is user-defined of calculated. Calculated is only possible for the oil model.

* (on the same line) 1 real for the radius (in metres) of the release in the horizontal x,y-plane. Particles are uniformly distributed within this circle.

- 1 real specifying the percentage of the total number of particles that is going to be used to model the effects of this release. For instance, if you specified 10000 particles and a percentage of 50.0 for this release, than 5000 particles will be released at this \((x, y)\)-co-ordinate (the mass corresponding to these particles must be specified below). The total percentages of all releases (inclusive the continuous releases) may be smaller or greater than 100 %, but in that case the number of particles released during the simulation will be less or more than the specified number of particles.

- for each substance the total mass that is going to be released (each values on a new line).

Continuous releases

1 ; number of continuous releases

'continuous release 1'
13210.00  14000.00  3 ; x-coord (m) y-coord (m) layer
0.000  50.00 ; radius (m) perc. of total particles (%)
1.000 ; scale factor for load (kg/s)
1 ; interpolation option (0=block 1=linear)

; released_concentrations (kg/m3)
0.000 ; Tracer
1.000e+005 ; Tracer con 52

; release rates
2
; dd hh mm ss rate (m3/s)
0 12 30 0 1.000
0 20 30 0 1.000

- One integer giving the number of continuous releases.
- a string containing the name of the release (at most 20 characters)
- 2 reals for the $x$- and $y$-co-ordinate of the release point.
- (on the same line) one integer $K$ giving, specified in the same way as for instantaneous releases.
- 1 real for the radius (in metres) of the release in the horizontal $x,y$-plane. Particles are uniformly distributed within this circle.
- 1 real specifying the percentage of the total number of particles that is going to be used to model the effects of this release.
- 1 real for the required scale factor on a new line.
- 1 integer to specify the interpolation option on a new line. A block function is specified by 0 and a linear interpolation by 1.
- For each continuous release specify the concentrations of all tracers. The concentrations of the different tracers for a particular release are specified on a new line. The information for the different locations is on separate lines. The order of the locations is the same as the definitions of the releases.

- Now the mass to be released must be specified. This is done by means of specifying breakpoints that are either interpolated using a block function (0) or using a linear interpolation (1) — see the information on the interpolation option above.
- An integer specifying the number of breakpoints.
- For each breakpoint specify the time (days, hours, minutes, seconds) and the release rate. For each breakpoint, the time and release rate of all releases are specified on the same line.

; User defined releases
0

- Instantaneous release or User-defined releases.
This option is no longer supported and should be set to 0.

; Decay rates
2
; dd hh mm ss decay rates (1/day)
0 12 30 0 0.000 0.000
0 20 30 0 0.000 0.000

- one integer representing the number of "breakpoints" to specify the time variable decay coefficient. At least two breakpoints are required. Each record consists of the following:
- 4 integers giving the time of a breakpoint (day, hour, minute, second).
- as many reals (on the same line as the breakpoint specification) as there are substances, giving the first order decay coefficient per substance. The decay coefficient is assumed to be specified in [$d^{-1}$]. This information must be specified for at least two breakpoints. The first breakpoint must be equal to the start time of the calculation, and the last breakpoint must be equal to the end time of the calculation.
Settling velocities

- Generalized settling formula
  \(0.0000\); exponent for \(c(-)\)
  \(1\); grid refinement factor for accurate settling(-)

Settling tables

2; table dimension

Tracer

<table>
<thead>
<tr>
<th>dd</th>
<th>hh</th>
<th>mm</th>
<th>ss</th>
<th>(A_0)[m/s]</th>
<th>(A_1)[m/s]</th>
<th>Period[h]</th>
<th>Phase[h]</th>
<th>(V_{\text{min}})[m/s]</th>
<th>(V_{\text{max}})[m/s]</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>12</td>
<td>30</td>
<td>0</td>
<td>1.000e-004</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>-10.000</td>
<td>1000.000</td>
</tr>
<tr>
<td>0</td>
<td>20</td>
<td>30</td>
<td>0</td>
<td>1.000e-004</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>-10.000</td>
<td>1000.000</td>
</tr>
</tbody>
</table>

Tracer con 52

<table>
<thead>
<tr>
<th>dd</th>
<th>hh</th>
<th>mm</th>
<th>ss</th>
<th>(A_0)[m/s]</th>
<th>(A_1)[m/s]</th>
<th>Period[h]</th>
<th>Phase[h]</th>
<th>(V_{\text{min}})[m/s]</th>
<th>(V_{\text{max}})[m/s]</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>12</td>
<td>30</td>
<td>0</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>-10.000</td>
<td>1000.000</td>
</tr>
<tr>
<td>0</td>
<td>20</td>
<td>30</td>
<td>0</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>-10.000</td>
<td>1000.000</td>
</tr>
</tbody>
</table>

The time-variable settling velocities are specified in m/s.
- One real specifying the exponent for the concentration dependent settling (explained in section 4.10.2).
- The grid refinement factor (integer), used to calculate the concentrations needed to drive the concentration dependent settling velocity. The grid refinement factor is a multiplier of the number of grid cells in the \(x\)- and \(y\)-direction (see the box Output Definitions). If particles stray outside the zoom window, then the settling velocity will be set to 0.
- One integer representing the number of “breakpoints” for the time function for the (first order) decay coefficient.
For each substance a block of data follows, specifying as many records as breakpoints. The following information should be present on each record:
- 4 integers giving the time breakpoint (day, hour, minute, second).
- 4 reals that specify the settling velocity: \(A_0\) [m/s], \(A_1\) [m/s], the period \(T\) [hours] and phase \(\varphi\) [hours], followed by the minimum and maximum allowable settling velocity. All values mentioned here are specified on the same line as the time of the breakpoint. For more information on the implementation of the time-variable settling velocities, see section 4.10.2.

Sediment/erosion parameters

- Critical shear stress for sedimentation (Pa)
- Critical shear stress for erosion (Pa)
- Chezy coefficient (m\(^{1/2}\)/s)

If the sedimentation/erosion option is switched on, the following constants must be given:
- Critical shear stress for sedimentation [Pa].
- Critical shear stress for erosion [Pa].
- Chézy coefficient [m\(^{1/2}\)/s].

Details of the sedimentation/erosion process are in section 4.10.2.

A.3 Oil module constants

In the previous section the Sub-datatype Oil Model did not contain any parameters because the tracer model does not require any. When setting up the oil module, a number of specific oil module parameters are required. In the box below an example is given of a model with two oil types, three discharges for which the discharge radius of two discharges are calculated instead of using the supplied discharge radius as given in the instantaneous and continuous discharges boxes. For details of the model specific parameters see section 4.10.4.
Following the specification of the number of constants for this block, for each oil type a block of 8 parameters is specified (see section 6.5):

- the evaporation rate (per day).
- the choice of the formulation to calculate the oil dispersion (entrainment of oil in water). The options are:
  0 the dispersion is specified as a probability per day. The effect is an exponential reduction of surface floating oil.
  1 the Delvigne/Sweeney formulation for the oil dispersion (entrainment) is used, which means that the parameter that is specified is the kinematic viscosity [cSt].
  * the dispersed fraction per day (option 0) or the value of the kinematic viscosity of the oil (option 1).
- The probability of a particle to stick to the bottom or land boundary.
- The volatile fraction, i.e. the fraction of the oil that can evaporate.
- Emulsification parameter $C_1$.
- Maximum water content (emulsification parameter $C_2$).
- Evaporated fraction at which emulsification starts.
- Density of oil.
- Kinematic viscosity of the oil.

Subsequent to the previous block follow some global oil parameters

- A real specifying the minimum oil layer thickness

$\Delta$ An integer specifying the deflection angle (in degrees, clockwise). This option is only applied in the 3D mode and for a 2DH model this parameter is not included in the input file.

A new setting not supported by the current GUI is a switch for sticking of oil at dry flats. To
include it, you will have to changing the first line to version V3.73.00 or higher, and add the follow parameter, without increasing the number of constants:

0 ; sticking at drying flats [0,1] ; (0=will not stick at dry flats, 1=will stick at dry flats)

A.4 Initial condition file for the oil module

The initial condition file (ASCII format) specifies one or more polygons that define surface oil patches. Each individual patch can be generated using QUICKIN, by creating a polygon file for each patch, for the file format see section A.5. If the polygon is not closed, then PART will close it by connecting the first and last co-ordinate of the polygon. More than one patch may be created. A header will then need to be added to each patch to specify the type and amount of oil for this patch and the number of particles associated with this patch. The type of oil will need to be the same as one of the oil types in the input file. An example of a initial conditions file is shown below.

* Fraction: Ekofisk
* Mass: 1000000 kg
* Particles: 10000
L00001
13 2
1.8809943E+05 6.1560469E+05
1.8784460E+05 6.1639466E+05
... 
1.8860074E+05 6.1533856E+05
1.8809943E+05 6.1560469E+05

* Fraction: Heavy Fuel Oil
* Mass: 1000000 kg
* Particles: 20000
L00002
22 2
1.9166405E+05 6.2069936E+05
1.9486139E+05 6.2244163E+05
... 
1.9110883E+05 6.1937831E+05
1.9166405E+05 6.2069936E+05

The keywords Fraction, Mass and Particles are compulsory. The * at the beginning of the line is also required. These three keywords are then followed by a specification of the polygon name. The next line specifies the number of rows and number of columns that define the polygon, followed by the x,y data.

This <*.ini> file can be visualised in the visualisation tool of the PART-GUI, by importing the file as a land boundary file.

In the input file the use of initial oil patches looks like:

; Initial condition (oil only)
  1; 0 = no initial particles
  1; initial oil patches (from *.ini file)
  'ekofisk_hfo.ini'; Initial condition file (including polygons describing the oil patches)

- An integer indicating if initial oil patches from a file are used.
- If for the oil module initial oil patches are required, then the name of this file is specified.
A.5 Polygon file

File contents: The co-ordinates of one or more polygons. Each polygon is written in a single block of data.

Filetype: ASCII

File format: Free formatted

Filename: <name.pol>

Generated: RGGRID, QUICKIN, D-WAQ DIDO, etc

Record description:

The file may contain one or more polygons. For every polygon the file should contain a line indicating the name of the polygon, followed by a line indicating the number of points making up the polygon and the number of coordinates, i.e. 2, finally followed by the coordinate data.

<table>
<thead>
<tr>
<th>Record</th>
<th>Record description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preceding description records, starting with an asterisk (*), and will be ignored.</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>A non blank character string, starting in column one</td>
</tr>
<tr>
<td>2</td>
<td>Two integers representing the numbers of rows and number of columns for this block of data</td>
</tr>
<tr>
<td></td>
<td>Two reals representing the ( x, y ) or ( \lambda, \phi )-coordinate</td>
</tr>
</tbody>
</table>

Restriction:

- The first record and the last record in the block should be the same

Example:

```
* 2008-09-25, 22:11:08
* *
Observation Area 001
  5 2
  1.8768018E+05 6.1708738E+05
  1.8996981E+05 6.101035E+05
  1.9746314E+05 6.1266423E+05
  1.9480925E+05 6.1838830E+05
  1.8768018E+05 6.1708738E+05
Observation Area 002
  5 2
  2.0011703E+05 6.1818015E+05
  1.9819166E+05 6.1063479E+05
  2.0568498E+05 6.0870942E+05
  2.0797461E+05 6.1599460E+05
  2.0011703E+05 6.1818015E+05
Observation Area 003
  5 2
  1.9340425E+05 6.1396516E+05
  2.0183425E+05 6.1365294E+05
  1.9944054E+05 6.0558720E+05
  1.9522555E+05 6.0595146E+05
  1.9340425E+05 6.1396516E+05
```
A.6 Initial condition file for the oil module

The initial condition file (ASCII format) specifies one or more polygons that define surface oil patches. Each individual patch can be generated using QUICKIN, by creating a polygon file for each patch, for the file format see section A.5. If the polygon is not closed, then PART will close it by connecting the first and last co-ordinate of the polygon. More than one patch may be created. A header will then need to be added to each patch to specify the type and amount of oil for this patch and the number of particles associated with this patch. The type of oil will need to be the same as one of the oil types in the input file. An example of a initial conditions file is shown below.

* Fraction: Ekofisk
* Mass: 1000000 kg
* Particles: 10000
L00001
13 2
1.8809943E+05 6.1560469E+05
1.8784460E+05 6.1639466E+05
...
1.8860074E+05 6.1533856E+05
1.8809943E+05 6.1560469E+05
*
* Fraction: Heavy Fuel Oil
* Mass: 1000000 kg
* Particles: 20000
L00002
22 2
1.9166405E+05 6.2069936E+05
1.9486139E+05 6.2244163E+05
...
1.9110883E+05 6.1937831E+05
1.9166405E+05 6.2069936E+05

The keywords Fraction, Mass and Particles are compulsory. The * at the beginning of the line is also required. These three keywords are then followed by a specification of the polygon name. The next line specifies the number of rows and number of columns that define the polygon, followed by the $x,y$ data.

This <$*.ini$> file can be visualised in the visualisation tool of the PART-GUI, by importing the file as a land boundary file.

In the input file the use of initial oil patches looks like:

```plaintext
; Initial condition (oil only)
1 ; 0 = no initial particles
; 1 = initial oil patches (from *.ini file)
‘ekofisk_hfo.ini’ ; Initial condition file (including polygons describing the oil patches)
```

- An integer indicating if initial oil patches from a file are used.
- If for the oil module initial oil patches are required, then the name of this file is specified.